Pocket Genealogist

Pocket Genealogist V4.00


Version

4.00
Pocket Genealogist ™
Northern Hills Software LLC
Pocket Genealogist
User Guide
Most examples in this user guide use the sample data from Legacy XE "Legacy Family Tree"  Family Tree (Millennia) and The Master Genealogist XE "The Master Genealogist" ™ (Wholly Genes).   There are differences between devices so what you see will be similar but may not be exactly the same.
Note: Colors on the 3-gen screen are user configurable.
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Northern Hills Software LLC XE "Contact Information" 
PO Box 403., El Dorado Springs, Missouri 64744
Fax: 417-876-3819
http://www.NorthernHillsSoftware.com 

http://www.PocketGenealogist.com
mailto:Support@NorthernHillsSoftware.com
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Chapter

1

Installation
Before Installation XE "Install:Pocket Genealogist" 

 XE "Install:Before Installation" 
New User

Microsoft ActiveSync XE "ActiveSync"  (XP and older) or Windows Mobile Device Center (Windows Vista and newer) must be installed and a connection established between your primary computer and device prior to installation of Pocket Genealogist.   ActiveSync is provided on a CD that came with your device or Windows Mobile Device Center can be found online at the Microsoft website.
Current Version 4 User

All Pocket Genealogist Version 4 releases can always be installed “overtop” your current release and no “manual” uninstall needs to occur first.    With Windows Mobile 5 or 6 devices, you will be prompted regarding the “automatic” uninstall of the program on the device prior to the installation of the new version.
Databases created prior to 4.00 are not compatible and will need to be re-imported.
Current Version 2 or 3 User

Pocket Genealogist Version 4 will not overwrite Version 2 or Version 3 when you install.  You may run both versions if you wish, they don’t share anything in common.   See Appendix A for more details regarding uninstall.

Installation of 4.00
Start by downloading the installation program from the Northern Hills Software website.   There are several different downloads. Choose the one that’s correct for your device, the website has details on how to make that distinction.
You should close any running copies of Pocket Genealogist on the desktop or the device prior to running the installation.  Make sure your device is connected before you run the Pocket Genealogist installation program.   You must have administrator privileges XE "Install:Administrator Privileges" 

 XE "Administrator privileges"  during installation although that is not required when you use the program.
There are two distinct steps to the installation which are invoked by running the installation program that you downloaded.  The first step will install the desktop side of Pocket Genealogist.  The second step will install Pocket Genealogist on your device.  Both steps are accomplished by running the single installation program. 
Note: If you need to re-install Pocket Genealogist XE "Re-installing Pocket Genealogist" 

 XE "Install:Re-installing"  on the device only, press the “Tools” button on the main Pocket Genealogist (on your desktop computer) and you’ll find a “Re-install” button.   Optionally, you can run the entire install again.   You should never need to uninstall a copy of Version 4 before re-installing.
Running the Installation program
Start the installation by clicking on the program setup file that you downloaded from the Northern Hills Software website. 
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The first panel allows you to select which language you wish to use for the installation wizard display.  The installation program will automatically try to select the correct language based on the value set in “Regional Settings XE "Regional Settings:Use of" ” on your computer.
Press “Next” to continue.
[image: image4.png]Pocket Genealogist V4 Instalation Wizard (4

License Agreement

Copyright and Terms of Use
Pocket Genealogist(tm) is the copyrighted work of Northern Hills Software LLC.

Use of the Software is governed by the following Terms of Use. ['License Agreement’)

/An end user who is willing to use the Software agrees to the License Agreement terms. The copyright is
owned by Northern Hills Software LLC. In no event shall Northern Hills Software LLC be liable for any special,
indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits

out of or in connection with the use or performance of the Software. Any rights not expressly granted
herein are reserved.

(C)1999-2010 Northern Hills Software LLC. All rights reserved.

1 Accept

Back Next Cancel





Select “I Accept” if you agree to the terms of the License Agreement.   You cannot continue the install without accepting the License Agreement.

Press “Next” to continue.
[image: image5.png]Pocket Genealogist V4 Installation Wizard
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If this is a new installation you can select where to install the program XE "Install:Installation location on desktop computer" .   Use the [image: image6.png]


 button to select the location using the standard windows “Browse for Folder” dialog.  A shortcut for Pocket Genealogist is always placed in the Programs menu. XE "Shortcut:Program (Desktop)" 

 XE "Install:Programs shortcut (Desktop)" 

 XE "Shortcut:Start Menu (Desktop)" 

 XE "Install:Start menu shortcut" 

 XE "Shortcut:Desktop" 

 XE "Install:Desktop shortcut"   You may also select to have a shortcut placed on your desktop or on the start menu.   Shortcuts can be defined as available for all users or just for the installation user. 
Press “Next” to continue.
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The next panel verifies that ActiveSync XE "ActiveSync"  (or Windows Mobile Device Center) is installed.   If it is not you will be shown a “Web” button which can be pressed to take you to the appropriate Microsoft website for download.  (An internet connection must be present for the button to work.)  You can continue to install without ActiveSync or Windows Mobile Device Center present BUT the device side of Pocket Genealogist will not be installed.

Press “Next” to continue.
[image: image8.png]Validating installation of Microsoft Database Drivers.

Microsoft Database drivers are installed and working.





The next panel verifies that the Microsoft database drivers XE "Microsoft database drivers" 

 XE "Install:Microsoft database drivers"  needed by the “Advanced” version of Pocket Genealogist for use with the direct imports from your desktop genealogy program are available.   If any are missing, it will tell you which ‘Direct’ import will not work.  If you are not using that desktop program, you can ignore this warning.  Otherwise, a ‘Web’ button will be displayed to allow download of the necessary driver.

Press “Next” to continue.
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The next panel will show you where the program will be installed and gives you one last chance to change options before installation.   (Use the “Back” button to change installation options)

Press “Install” to start the installation.
[image: image10.png]Pocket Genealogist V4 Installation Wizard (4.00)

Press the 'Install’ button to begin Installation.
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The next panel shows the progress of the installation and displays the files that are copied to your computer.   After the desktop side is complete, you’ll receive the ActiveSync or Windows Mobile Device Center XE "ActiveSync"  installation panel for the device install. (as shown on the next page).
PocketPC 2003 Device
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If you wish to install Pocket Genealogist to device “memory”, select “Yes”.  If you wish to install Pocket Genealogist to an external storage card (if available), select “No”.  Selecting “No” gives you a “Select Destination Media” screen similar to the illustration to the right.  (The arrow in the drop down list has been selected for this screen print)

Note: If this is a re-install of Version 4, you may see the following screen.
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Windows Mobile 5 or 6 devices XE "Windows Mobile 5 or 6"  XE "Install:Windows Mobile 5 or 6devices" 
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You do not select where you want the program to be installed from the desktop.    The device installer (shown to the right) will automatically copy the install program to the device and you will be prompted on the device to continue the install.

Note: If this is a re-install of Version 4, you may see the following screen.
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The first prompt you should see on the device is the “unknown publisher” XE "Unknown Publisher:Device Install" 

 XE "Install:Unknown Publisher (device)"  confirmation.  The Pocket Genealogist install is not a “signed” application so you will need to select “Yes” to continue.
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  or
[image: image326.png]


Note: If this is a re-install of Version 4, you will first be prompted to remove the prior version.   The un-install will also give you the choice of removing the old databases and configuration settings.  (In most cases, you would probably remove neither.)
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Next you will get the prompt that will allow you to choose the location on the device XE "Install:Storage Card (Windows Mobile 5 devices)" 

 XE "Install:Installation location for Windows Mobile 5 devices"  to install the program.  Press “Install” on the menu to continue.    

Note: You may not see this prompt if you do not have any storage cards in the device.
You may get a prompt if the current settings on the device will prevent Pocket Genealogist from performing synchronizations XE "RAPI Security Policy" 

 XE "Install:RAPI Security Policy (Windows Mobile 5 Devices)"  from the desktop.  You should select “Yes” if you get this prompt.
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And finally you will be shown a screen indicating success or failure.  Press “OK” or “Done” to dismiss this dialog. 
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 or
You may now continue with the installation on the desktop.
Final Installation Steps 

After device installation, you will receive the following message on the desktop:
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When the installation is complete, a success or failure message will be displayed in the window.

Press “Next” to continue.
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This is the final panel that will be displayed.   Pocket Genealogist will automatically start unless you uncheck the “Launch Program on exit” option.

Press “Finish” to exit the wizard.
Desktop Setup XE "First time you run Pocket Genealogist:Desktop Setup" 

 XE "Desktop Setup of Pocket Genealogist" 
The first time you run the Pocket Genealogist program on the desktop there are a couple of things to set.

Location of Databases 

You will be asked to select the location for the Pocket Genealogist databases and other common files.  This prompt will only occur the first time you run Pocket Genealogist.
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Note: You can reset this later by removing the Pocket Genealogist customization values.  See “Remove Customization Values XE "Remove Customization Values:Desktop" ” for more detail.
Registration Code XE "Registration (unlock) code" 
You will be prompted to enter your registration code.  You can use the program without a registration code by pressing “OK” but some features will be disabled.   
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If you have already purchased Pocket Genealogist, press the “Register” button to enter your unlock code.
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Enter your registration/unlock code provided in the email received from the vendor from which you purchased Pocket Genealogist.  The first time you synchronize a database it will also automatically enter the code for you on the device.

Options
You may want to select the “Options” button on the main Pocket Genealogist screen to set some values to improve the Pocket Genealogist experience.   Most of these options can be set during operation of Pocket Genealogist although you may wish to preset these values before you begin.
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File Locations  XE "Options:Import Location on desktop" 

 XE "The Master Genealogist:Import Location" 

 XE "RootsMagic:Import Location" 

 XE "Legacy Family Tree:Import Location" 

 XE "GenBridge:Import Location" 

 XE "Genbox:Import Location" 

 XE "Import Location:The Master Genealogist" 

 XE "Import Location:RootsMagic" 

 XE "Import Location:Legacy" 

 XE "Import Location:GenBridge" 

 XE "Import Location:Genbox" 

 XE "Import Location:GEDCOM" 

 XE "Import Location:Ancestral Quest" 

 XE "GEDCOM:Import Location" 

 XE "Ancestral Quest:Import Location" 
You can set the “default” location to look for your import files when you do a “Create”.  Press the appropriate button to bring up a “Browse” dialog so you can select the folder on your desktop to use as the default location for that type of import.

Sound to Play at completion XE "Sounds:At completion of an event" 

 XE "Sounds:Synchronization complete" 

 XE "Sounds:Import complete" 

 XE "Sounds:Export complete" 

 XE "Options:Sounds" 
With large amounts of data, it may take some time to perform an import, export or synchronization.  You can set a sound to play when these operations complete as a means to notify you that the operation is complete.  Pressing the appropriate button (import, export, sync) invokes an “open” dialog so you can select the “WAV” file.  (Look in C:\windows\media for some “WAV” files that may come with your operating system.)

Miscellaneous Defaults

Lock Data (View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" )
If you do not want to do data entry on the device, you can “lock” the data to prevent accidental changes to the data.  Setting this value will set this as the default for when you do imports.  (Changing this after you do an import does nothing for any databases you’ve already created without this value set.)   This value is selectable at import time, but the selection you have on this screen will be used as the default when you do an import so that you don’t have to remember to set it every time an import occurs.
Save Column Width and Position XE "Lists:Column Width" 

 XE "Lists:Column Position" 
Selecting this option allows you to save the width and position of columns for the various “lists” found in the desktop Pocket Genealogist program.   If this is not selected, you can still change the width and position of the columns but they won’t be saved when you exit Pocket Genealogist.

Advanced Options

The “Advanced” button is used to display the Advanced program options.    
Advanced Options XE "Advanced Options:Desktop" 
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Maximum Target Image Size / Resolution
Pocket Genealogist converts a copy of your images to JPEG and resizes them to more closely match the display of the device.   (This allows for much smaller image sizes)    You can select the ‘target’ image size if you wish to have higher resolution images although be cautious with the “Original Size” option as synchronization can take a long time.   Additionally, large images on the device may not display because of memory constraints.
Code Page XE "Code Page:Setting" 
Except in rare situations (Vietnamese for example), the Code Page should always be set to 1252 (ANSI – Latin I).     You can use the “default” button to set the value back to this value.
Use TCP/IP for communications

You should not need to set this option in order to make synchronization work.  If normal communications is unsuccessful, the program will automatically try the “TCP/IP” option.

“Let device determine address for Synchronization” should always be selected and “Manual Synchronization” not selected unless you have specific needs which have been previously discussed with Northern Hills Software.  (For example, these can be used to establish a Wi-Fi connection with Windows Mobile 5 or 6 devices)
Synchronize to location with most free space XE "Synchronization:Location with most space" 
Most devices have multiple locations available for synchronizing databases.   (Memory, File Store and Storage Cards for example)   If you have this option selected, the location with the most free space will be automatically selected on the synchronization screen when you first sync a database.  (although you can change the value to any location you wish before starting the sync)
Synchronize Pocket Genealogist device configuration values XE "Synchronization:Device Configuration" 
Configuration options you select on the device can be synchronized to the desktop for “safe keeping” so that if you should have a “hard reset” on the device they can be restored.   Select this option to retrieve and save these values on your desktop computer.
Languages

Selecting or de-selecting the languages you wish to synchronize to the device is accomplished on this screen.    You can either synchronize these languages using the “Synchronize” button or automatically when you synchronize a database.   If you previously synchronized a language but then de-select it on this screen, the next synchronization will remove that language from the device.
Chapter

2
Getting Started (Desktop) XE "Getting Started:Desktop" 
Getting your data to the device
Overview
Your genealogy data is not directly copied to the device.   Instead, you import your genealogy data into a Pocket Genealogist database which is then synchronized to the device.   This is all accomplished with the desktop portion of the Pocket Genealogist program.  Pocket Genealogist can read your data in a number of ways.  
· GEDCOM XE "GEDCOM"  file – GEDCOM, or GEnealogical Data COMmunication,  is the data transfer “standard” for exchanging information between genealogy programs.   It was developed by the Church of Jesus Christ of Latter Day Saints.   All modern desktop genealogy programs can create a GEDCOM file.  See Appendix B for examples on how to create a GEDCOM file from some popular genealogy programs.  Pocket Genealogist supports ANSI XE "ANSI" , ANSEL XE "ANSEL" , UTF-8 XE "UTF-8"  and Unicode XE "Unicode"  based GEDCOM files.
· “Advanced” Pocket Genealogist only: You can bypass GEDCOM XE "GEDCOM"  and directly read databases created with Ancestral Quest XE "Ancestral Quest" , Genbox XE "Genbox"  Family History Version 3, Legacy XE "Legacy Family Tree"  Family Tree Version 5 and higher, RootsMagic XE "RootsMagic"  Version 2 and higher, and The Master Genealogist XE "The Master Genealogist"  Versions 5 and higher.  Pocket Genealogist also supports updating changes made on the device directly back into Legacy when the 2-way synchronization option is turned on.
· “Basic” or “Advanced” with the PAF/FTM XE "PAF/FTM add-on"  add-on: The Pocket Genealogist PAF/FTM add-on available from Wholly Genes Software allows you to directly read PAF XE "Personal Ancestral File"  Version 5 or Family Tree Maker XE "Family Tree Maker"  databases (except for FTM 2010).   The add-on is for import only, not  XE "Import" 

 XE "Database:Import" 2-way Synchronization.
When you create a new Pocket Genealogist database to go onto the device, it first stores your information in a Pocket Genealogist database on the desktop then synchronizes it to the device.   If you make changes to the data on the device and synchronize it back to the desktop, it puts the changes back into the Pocket Genealogist database it created there.   If you are doing 2-way Synchronizing XE "Synchronization:2-way" 

 XE "2-way Synchronizing"  with Legacy XE "Legacy Family Tree"  Family Tree, it will then update Legacy using that Pocket Genealogist database.   If you are doing any other type of import, you can use the “Export” feature of Pocket Genealogist to create a GEDCOM XE "GEDCOM"  for merging back into your original genealogy database.    

The steps for getting your data to the device, which will be covered in detail in this chapter, are as follows:

1. Create.  This starts the process of creating a Pocket Genealogist database on the desktop which will be synchronized to the device.

2. Import XE "Import" 

 XE "Database:Import" .  This step reads your genealogy data and puts it in the Pocket Genealogist database on the desktop.   When you do your first import you will need to set some “customization” options for what type of data you wish to import.  This allows you to selectively pick the data you wish to import in case you wish to conserve space on the device.
3. Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" .  This step takes the Pocket Genealogist database on the desktop and copies it to the device.
When you first start the program and before you create any new databases, you will have a “blank slate” showing no Pocket Genealogist databases as illustrated on the following screen.
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Tip: XE "Tips"  Most buttons in Pocket Genealogist have “Tips” associated with them.  Hover your mouse pointer over the button to display more information. 
Tip: XE "Tips"  Most Pocket Genealogist screens can be resized both vertically and horizontally.  The size and position of the screen will automatically be saved. 
The layout of the main Pocket Genealogist screen is divided into roughly four areas from top to bottom:
1. Database List.  This list shows the Pocket Genealogist databases that have been created and information about that database. This information includes the database name, the type of  import, whether the database is “locked” as read/only, whether 2-way synchronization is in effect, the status of the last action against the database, the date the database was lasted acted upon using the action buttons, and the original location of the imported data.
2. Action Buttons.  This contains buttons that allow you to perform actions against the databases in the list. (in the previous example most of the action buttons are invisible since no databases have been created yet)   
3. Log Window. The “Log” window contains information about the actions you have taken since starting Pocket Genealogist.

4. Additional Options.  These buttons are other actions you can take that are not specific to a database.

Tip: XE "Tips"  Use the “About” button to enter your registration (unlock) code before you create your first Pocket Genealogist database. 
Creating a Pocket Genealogist Database XE "Database:Creation" 
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 The first step in getting your genealogy data to the device is to create a new Pocket Genealogist database.   Use the “Create” button on the main desktop screen to start the process.   
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The first thing you must select is how you are getting the data into the Pocket Genealogist database.  The import types are grouped by the level of Pocket Genealogist you have purchased.  All “Basic” features are also available if you have the “Advanced” level of Pocket Genealogist.   If you are using the “Trial” level the only available option is “GEDCOM XE "GEDCOM" ”.    
The use of the PAF/FTM add-on XE "PAF/FTM add-on"  requires the additional purchase of the item from Wholly Genes Software.  
Select the import type and press the “OK” button to continue.
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When you do an import and no files are found in the “default” location or that type of import, you will be prompted if you wish to search your computer for files that qualify for that type of import.

This is useful if you don’t know where your genealogy data is stored on your computer.  Be aware that the search may take some time to run if you have a lot of folders and files on your computer although you do have the option of aborting the search at any time.    For illustration purposes, we will assume that “No” is selected.   
The “file selection” screen is shown next.   The current default path for the type of import selected will be displayed in the edit field at the top of the screen and any files/databases that match for this location will be displayed in the list.  (In this example there are no matches)   If the file/database you wanted to import was in the list, you could simply select that item then press the “OK” button to continue.
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Since there are no items in the list, you must “navigate” to the location containing the data.  Here are the options for selecting data from this screen:

1. Select from the list.  If the file you want to import is in the list, simply select that item in the list using a single left mouse click.

2. Open dialog.  Press the “Open” button [image: image25.png][0




 to invoke the Windows file selection dialog which can be used to navigate to the file you wish to import.

3. Enter the Location.  [image: image26.png]i1




  If you know the location of the data, enter the full path in the edit field (path only) and press the “Refresh XE "Refresh" ” button to display a list of files at that location. 

4. Search. Press the “Search” button [image: image27.png]


 to display the search screen. 
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If you are on a network and wish to have network drives searched along with local drives, select the “Include Network Drives” option.  You can also search removable media such as floppy drives, Zip disks, and memory drives.

The search can take some time depending on the number of files and folders and hard drives you have in your system.   At times it may appear to be “hung” if there are lots of files in any particular folder.   If the file you are searching for appears in the search list you can press “Stop” to stop the search.   Selecting an item from the search list and pressing “OK” will select that file for import.

Importing XE "Importing"  data into the Pocket Genealogist database

Customizing the Import XE "Options:Customizing the Import" 

 XE "Import:Customizing" 

 XE "Customizing the Import" 
The second step in getting your genealogy data to the device is importing the data selected in the “Create” step into the desktop Pocket Genealogist database.    The first time you import a database of a particular type (GEDCOM XE "GEDCOM"  for example), you will be prompted to set the customization values for that import.
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Press the “Customize” button on the import screen to set the options you wish to use for that type of import.
Customizing GEDCOM imports XE "Import:Customizing GEDCOM imports" 

 XE "GEDCOM:Customizing the Import" 
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Note:  Not all options are applicable for every type of GEDCOM XE "GEDCOM"  import.   The availability of that type of data depends on your desktop genealogy program.  However, selecting an option that is not applicable will do no harm.

Dual Surname XE "Surname:Dual" 

 XE "Dual Surname"  Support (Spanish Style) – Select this option when both the mother’s and father’s surnames are used as part of the full name for the children of that couple.   

Uppercase Surnames XE "Uppercase Surnames" 

 XE "Surname:Uppercase"  – Converts surnames to all uppercase during import.

Include section -- This section contains options for selecting the data you wish to include as part of the import.  Some of these options may not be applicable for all GEDCOM XE "GEDCOM"  imports.   Warning: Selecting “Primary Events XE "Primary Events" 

 XE "Events:Primary"  Only XE "Primary Events Only" 

 XE "Events:Primary Only" ” will discard all events other than “primary” events. (Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event" )
Multimedia XE "Import:Multimedia, GEDCOM" 

 XE "Multimedia:Import, GEDCOM"  – This option allows the importation of images (photos for example).

Primary Events XE "Primary Events" 

 XE "Events:Primary"  First XE "Primary Events First" 

 XE "Import:Primary Events First"  -- “Primary” events (birth, christening, death, burial, marriage) will appear first in the event list on the device.  If not selected, events are strictly sorted by date.

Display messages for unsupported TAGS XE "Unsupported GEDCOM Tags" 

 XE "Import:Unsupported Tags" 

 XE "GEDCOM:Unsupported Tags"  – Some GEDCOM XE "GEDCOM"  tags are not supported during import.  If you wish to see messages when these tags are encountered, select this option.

Double Dating XE "Double Dates" 

 XE "Dates:Double"  – Allows you to select the beginning and ending date to use for double dating (Julian to Gregorian calendar switch).  This option may not be available for all GEDCOM XE "GEDCOM"  imports.

Comment / Location XE "Options:Comment / Location Import Options" 

 XE "Import:Comment / Location options"  – For some import types, you are allowed to define how the comment and location is imported.  For example, Family Tree Maker XE "Family Tree Maker"  and Brother’s Keeper allow a location and a comment in the same data field.  With the third and fourth option, you can specify the character that is used to separate the two values.

Size Limits XE "Limiting:Size of Event Notes" 

 XE "Size Limits" 

 XE "Limiting:Size of Citation Notes"  – If you have a large number of source citation XE "Citation (Source)"  or event notes, you may want to limit the maximum size (in characters) of imported notes so the database doesn’t get too large to synchronize to the device.  The default value is 0 which means that the entire note will be imported.    The minimum value you can specify is 20.   If during the import a note larger than the limit is encountered, it will only import the indicated amount and discard the rest.   If you do “limit” the size of the note, it is recommended that you also turn on “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”.
Customizing Legacy Family Tree “Direct” Imports XE "Legacy:Customizing the Import" 

 XE "Import:Customizing Legacy imports" 
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On this screen you can select which events, notes, and other items to include during import of the Legacy XE "Legacy Family Tree"  data.  If you are doing 2-way synchronizations, you must select all options.  (Use the “Select All” button.)   The only exception is  XE "Multimedia:Import, Legacy Family Tree" 

 XE "Import:Multimedia, Legacy Family Tree" Multimedia which you can leave unselected but still enable 2-way synchronizing.
The “Legacy XE "Legacy Family Tree"  Installation XE "Legacy Family Tree:Legacy Installation" ” value is used to retrieve configuration options set in Legacy.  You can either manually enter the path where Legacy is installed or press the “Version” button to select the path.  You can also press the “Search” button if you do not know where Legacy is installed.

Note: If you use the “Search” button it will search all hard drives on your system.  If during the search it finds the location and displays it in the list, you can press the cancel button to stop the search and pick that location.

Treat suffix as dual surname XE "Surname:Dual" 

 XE "Dual Surname" 
This option is similar to “Dual Surname XE "Surname:Dual" 

 XE "Dual Surname"  (Spanish Style)” found on GEDCOM XE "GEDCOM"  imports and allows you to use the suffix field in Legacy XE "Legacy Family Tree"  as the second surname.
Customizing The Master Genealogist “Direct” Imports XE "The Master Genealogist:Customizing the Import" 

 XE "Import:Customizing The Master Genealogist imports"  [image: image32.png]fEmpes
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Location – Select which location elements you would like to include during import.

Latitude XE "Coordinates:Latitude"  / Longitude XE "Longitude (Coordinates)" 

 XE "Latitude (Coordinates)" 

 XE "Coordinates:Longitude"  – Select this option if you wish to include the latitude and longitude value associated with the location.

Reverse Order – Reverses the “order” of the location XE "Location:Reversing Order"  that is built using the elements selected.  (For example, builds the location string as [L8], [L7], [L6], etc.)

Commas when missing XE "Location:Commas when missing"  – When building the location string, if an “element” is missing in the data, this option will retain the space for that element by putting in a comma.

Double Dates (Old Style Dates) – Allows you to set the first and last date used for old style dates.

Remove Format Codes XE "Remove Format Codes" 

 XE "Notes:Format Code removal" 

 XE "Format Codes:Removing"  – Select these options to remove any formatting codes that may be included in the original data.

Include – Various options for selecting what data types you want to include with your import.  You can use this to decrease the amount of space needed for your database.  
Primary Events XE "Primary Events" 

 XE "Events:Primary"  Only XE "Primary Events Only" 

 XE "Events:Primary Only"  - This selection will cause non-Primary events to be discarded during import.   If selected, only Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event"  events are honored.   This allows you to limit the amount of data sent to the device if you are trying to conserve space.

Witnesses XE "Roles and Witnesses"  – Roles and Witnesses can be transferred to the device although they cannot be edited on the device as The Master Genealogist XE "The Master Genealogist"  does not allow for this information to be transferred via GEDCOM XE "GEDCOM" .
Custom Flags XE "Import:Customizing RootsMagic imports" 

 XE "Flags:Custom"  - If you select “Custom Flags”, you will be presented with a “flag selection” screen during import.  (TMG XE "The Master Genealogist"  Version 5 and higher databases only.)  This will allow you to pick the flags to import since they can take up a lot of space in the Pocket Genealogist database.
To Do XE "To Do"  (Research Log XE "To Do:Research Log" 

 XE "Research Log (See also To Do)" ) – The Research Log can be transferred to the device although it cannot be edited on the device as The Master Genealogist XE "The Master Genealogist"  does not allow for this information to be transferred via GEDCOM XE "GEDCOM" .
Multimedia –  XE "Multimedia:Import, The Master Genealogist" 

 XE "Import:Multimedia, The Master Genealogist" This option if enabled allows the transfer of images (photos for example) to the device.   
All events at individual level – Events with a principal 1 and 2 that match the same principals in a marriage can be displayed at the “Individual” level instead of the “Family” level in Pocket Genealogist.   This option more closely matches how data is displayed in The Master Genealogist XE "The Master Genealogist" .

Customizing Genbox Imports XE "Import:Customizing Genbox imports" 

 XE "Genbox:Customizing the Import" 
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Note: The options which are not applicable for the import will be disabled.    Repositories will be enabled for selection when you select “Sources XE "Sources" ”.

Primary Events XE "Primary Events Only" 

 XE "Events:Primary Only"  ONLY: This selection will cause non-Primary events to be discarded during import.   If selected, only Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event"  events are honored.   This allows you to limit the amount of data sent to the device if you are trying to conserve space.

The rest of the items in the “Include” section allow you to pick the type of data you wish to synchronize to the device.

Preferred Folder for Media Files XE "Uppercase Surnames" 

 XE "Surname:Uppercase"  – XE "Import:Multimedia, Genbox" 

 XE "Multimedia:Import, Genbox"  If importing multimedia files, this field defines the preferred media file location as specified in Genbox.  This field will automatically be filled in with the value used in Genbox, but you can override it if incorrect.   (This value is the “Preferred Folder for Media Files (“pref”) value found under “View”, “Preferences”, “Operation” tab in Genbox)

Customizing Other “Direct” Imports XE "Import:Customizing RootsMagic imports" 

 XE "RootsMagic:Customizing the Import" 

 XE "Import:Customizing Ancestral Quest imports" 

 XE "Ancestral Quest:Customizing the Import"  (AQ XE "Ancestral Quest" , RootsMagic XE "RootsMagic" )
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Note: The options which are not applicable for the import will be disabled.    Repositories will be enabled for selection when you select “Sources XE "Sources" ”.

Primary Events XE "Primary Events" 

 XE "Events:Primary"  ONLY: This selection will cause non-Primary events to be discarded during import.   If selected, only Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event"  events are honored.   This allows you to limit the amount of data sent to the device if you are trying to conserve space.

The rest of the items in the “Include” section allow you to pick the type of data you wish to synchronize to the device.
Multimedia –  XE "Multimedia:Import, Ancestral Quest 

 XE "Import:Multimedia, Ancestral Quest"  XE "Multimedia:Import, RootsMagic

 XE "Import:Multimedia, RootsMagic" This option if enabled allows the transfer of images (photos for example) to the device.   If you wish to limit the amount of images for space or increased synchronization speed, you can select “Primary Only”.  (not applicable for all imports)
All events at individual level – “Family” events such as marriage can be displayed at the “Individual” level if this option is selected.  Both spouses will show the same event when viewing “Individual” information for that person.
Uppercase Surnames XE "Uppercase Surnames" 

 XE "Surname:Uppercase"  – Converts surnames to all uppercase during import.

Customizing PAF/FTM add-on  Imports XE "Import:Customizing Family Tree Maker (PAF/FTM add-on) imports" 

 XE "Personal Ancestral File:Customizing the PAF/FTM add-on Import" 

 XE "Import:Customizing PAF (PAF/FTM add-on) imports" 

 XE "PAF/FTM add-on:Customizing the import" 

 XE "Family Tree Maker:Customizing the PAF/FTM add-on Import" 
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Note: Not all options are available for both PAF XE "Personal Ancestral File"  and FTM XE "Family Tree Maker" .

Include – Various options for selecting what data types you want to include with your import.  You can use this to decrease the amount of space needed for your database.  

Primary Events XE "Primary Events" 

 XE "Events:Primary"  Only XE "Primary Events Only" 

 XE "Events:Primary Only"  -- This selection will cause non-Primary events to be discarded during import.   If selected, only Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event"  events are honored.   This allows you to limit the amount of data sent to the device if you are trying to conserve space.

Multimedia –  XE "Multimedia:Import, PAF/FTM Add-on" 

 XE "Import:Multimedia, PAF/FTM Add-on" This option if enabled allows the transfer of images (photos for example) to the device.   This option is only applicable for PAF and Family Tree Maker 2008 (or newer) imports.

Comment / Location XE "Options:Comment / Location Import Options" 

 XE "Import:Comment / Location options"  – Family Tree Maker XE "Family Tree Maker"  allows a location and a comment in the same data field.  This allows you to pick how you want to process that field as it is imported from FTM.   With the third and fourth option, you can specify the character that is used to separate the two values.

Note: As of Family Tree Maker XE "Family Tree Maker"  Version 2006, this “Comment” field appears to be solely a “Place XE "Place" 

 XE "Location:Place" ” field.  
Other Import XE "Import" 

 XE "Database:Import"  Options

Now that you have customized your import and saved those values for future use, you have other options you can choose before you start the actual import of your genealogy data.   After selecting those options, press “Start” to begin the import. 
GEDCOM XE "GEDCOM"  Import XE "Import" 

 XE "Database:Import"  Options
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Pocket Genealogist Database - The name of the Pocket Genealogist database will automatically be selected based on the name of the original file.   However, you can change the name to whatever you wish.   If a database by that name already exists on the device, it will be overwritten.
Lock data (View only) – If you don’t want to allow data entry for this database on the device, you can turn on this option to prevent accidental changes.

Profile – This will automatically be selected based on the GEDCOM XE "GEDCOM"  file you are using in the import.  Profiles are used to select the proper options needed to ensure a correct import of the data.   They also provide information to the device side of Pocket Genealogist so that the program matches the capabilities of the genealogy program that created the GEDCOM file.
Legacy XE "Legacy Family Tree"  Family Tree Import XE "Import" 

 XE "Database:Import"  Options
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Pocket Genealogist Database - The name of the Pocket Genealogist database will automatically be selected based on the name of the original database.   However, you can change the name to whatever you wish.   If a database by that name already exists on the device, it will be overwritten.
Lock data (View only) – If you don’t want to allow data entry for this database on the device, you can turn on this option to prevent accidental changes.

Enable 2-way Synchronizing XE "Synchronization:2-way" 

 XE "2-way Synchronizing"  – Use this option if you wish to enable the ability to synchronize changes made on the device directly back to your Legacy XE "Legacy Family Tree"  database, or changes made in Legacy to your device.  When using this option, you can only change Legacy or Pocket Genealogist between synchronizations.  (Either side can be changed but not both.)  After changing either the device database or the Legacy database, do a “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” in order to get the databases back in sync.   Afterwards, you can then change either side again but only one side at a time.

Note: All options available on the “Customize” screen and “All Records in the Entire Family File” will also be selected if you pick the “Enable 2-way Synchronizing XE "Synchronization:2-way" 

 XE "2-way Synchronizing" ” option.

Note: It is recommended that you do a “Check/Repair” of your Legacy XE "Legacy Family Tree"  database before you do the initial import.  See Chapter 6 for more details.
Note: If you wish to not make changes on the device but still want to retrieve changes in Legacy XE "Legacy Family Tree"  and synchronize them with the device, select both “Lock Data” and “Enable 2-way Synchronizing XE "Synchronization:2-way" 

 XE "2-way Synchronizing" ”.

Record Selection – Use the following options to pick the individuals you would like to import.

All Records in the Entire Family File – All individuals in the Legacy XE "Legacy Family Tree"  database will be imported.   No other options are available or will be shown.

All Records with an Individual Tag of – All individuals in the Legacy XE "Legacy Family Tree"  database with the tag specified will be imported.  (You have to set this tag from within the Legacy program.)  You can optionally select spouses, children and parents of the tagged individuals even if they are not tagged.
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All Records with a Marriage XE "Marriage Event" 

 XE "Events:Marriage"  Tag of – All individuals in the Legacy XE "Legacy Family Tree"  database associated with the family record with the tag specified will be imported.  (You have to set this tag from within the Legacy program.)  You can optionally select the children of the tagged individuals even if they are not tagged.
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The Master Genealogist XE "The Master Genealogist"  Import XE "Import" 

 XE "Database:Import"  Options
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Pocket Genealogist Database - The name of the Pocket Genealogist database will automatically be selected based on the name of the original database.   However, you can change the name to whatever you wish.   If a database by that name already exists on the device, it will be overwritten.
Lock data (View only) – If you don’t want to allow data entry for this database on the device, you can turn on this option to prevent accidental changes.

Dataset dropdown list – Use the “drop down list” to pick which dataset you would like to import from the TMG XE "The Master Genealogist"  project.

Note: The “DataSet Locked” and “DataSet Disabled” indicate the value as set in TMG XE "The Master Genealogist" , not something you can change prior to import.
Other “Direct” Import XE "Import" 

 XE "Database:Import"  Options (AQ XE "Ancestral Quest" , Genbox XE "Genbox" , RootsMagic XE "RootsMagic" )
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Pocket Genealogist Database - The name of the Pocket Genealogist database will automatically be selected based on the name of the original database.   However, you can change the name to whatever you wish.   If a database by that name already exists on the device, it will be overwritten.
Lock data (View only) – If you don’t want to allow data entry for this database on the device, you can turn on this option to prevent accidental changes.

PAF/FTM add-on  XE "PAF/FTM add-on" Import XE "Import" 

 XE "Database:Import"  Options
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Pocket Genealogist Database - The name of the Pocket Genealogist database will automatically be selected based on the name of the original database.   However, you can change the name to whatever you wish.   If a database by that name already exists on the device, it will be overwritten.
Lock data (View only) – If you don’t want to allow data entry for this database on the device, you can turn on this option to prevent accidental changes.

Profile – You may have the choice of picking a profile that matches the genealogy program you are using.  (PAF XE "Personal Ancestral File"  will only show “PAF v5” in the list.)   Pick the profile that best matches the version of the desktop genealogy program you are using.  It will remember which value you select for future imports.
Synchronizing XE "Synchronization:Database" 

 XE "Database:Synchronization"  the data to the device

The third step in getting your genealogy data to the device is synchronizing the Pocket Genealogist database to the device.   

Note: If there were errors during the import step, the synchronization screen will not be shown.
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You must have your device turned on and connected to your desktop/laptop computer and an active ActiveSync XE "ActiveSync"  (or Windows Mobile Device Center) session in order to synchronize.   If you do not, you will see the following screen.
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Once you have a connection, the above screen will automatically disappear.
Prior to starting the synchronization, you can select where you want your Pocket Genealogist database stored on the device.    Use the drop down list at the top left of the synchronization screen to pick the location. 
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The amount of space already used for that location will be shown to the right and will be updated automatically to show current space utilization while synchronization progresses.    In the above example, there is about 92MB of memory of which 12MB is already in use.  (12% utilized)

Note: If you want to edit your data, it is recommended that you put the database in memory.  Editing the database on a storage card can be significantly slower.   Never do a soft reset XE "Soft Reset" 

 XE "Device:Soft Reset"  when you are updating a database to a storage card even if you think the program is “hung”.   (It can be that slow at times!)  Doing a soft reset during a database update will corrupt the database.
After selecting the location to store the database on the device, press “Start” to perform the synchronization.  When it completes, barring any errors, you are now ready to use your database on the device.
Chapter

3

Getting Started (Device) XE "Getting Started:Device" 
Screen “Print” examples
Pocket Genealogist supports a wide range of devices with different types of screen resolutions and orientations.   Most of the examples in this user guide are for “Portrait” Touchscreen devices although “Landscape” and Non-Touchscreen examples will also be shown as necessary.   

Some devices support the ability to switch the orientation and Pocket Genealogist will automatically adjust to the new layout “on the fly” if the orientation switch is done using the Pocket Genealogist menus.

Registration (unlock) code XE "Registration (unlock) code" 
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The first time you synchronize a database, it will automatically enter your registration code from the desktop to the device.   You can also use the “Register” button or menu item to enter your code.
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 or
Note: The example screen prints have color customization already set.  You can set your own preferences by selecting “Edit”, “Configuration XE "Configuration" ” from the menu.
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Open your database XE "Opening a device database" 

 XE "Database:Open (Device)" 
By default when you start Pocket Genealogist, it will display a list of databases you have synchronized to the device.   If you have not synchronized any databases, refer back to Chapter 2.
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Select the database you wish to open by using a single tap of the stylus on the database name in the list, then press the Open button.     Double tapping the name in the list will also open the database.    
You can also use the “Directional Pad” button to “scroll” down in the list to select the database, then press the “D-Pad” to open it.
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Note: Non-Touchscreen devices do not have icons for selecting the actions.   All actions are accomplished by using the 5-way directional button (d-pad) or using the menus at the bottom of the screen.  (Which can be selected using the two menu buttons on the device)   Throughout this document the references to the iconic buttons to perform an action are substituted with menu items.   The same menus, in most cases, will also be available on Touchscreen devices.

3-Generation XE "View:3-Generation" 

 XE "3-Generation View"  View
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The 3-Generation XE "View:3-Generation" 

 XE "3-Generation View"  view is the default “view” of your database.   The layout of the screen is divided into 4 areas.  

1. Current Couple XE "Current Couple"  – In the middle of the screen are the male and female “couple” that are currently selected.  All other information on the screen relates to this “Current Couple”.

2. Children – The list below the current couple is the children of that union.

3. Marriage XE "Marriage Event" 

 XE "Events:Marriage"  – Above the current couple is the marriage or union information for that couple.  To the left are buttons to select other spouses or parents for the male and to the right for the female.

4. Parents – Above the marriage box are the parents of the current couple.  
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The 3-gen screen is used to both navigate through the database as well as viewing the information about the current couple.   Using your stylus, if you tap on one of the parent boxes, that person will become the “Current Couple XE "Current Couple" ” and the other information on the screen will change relative to that person.   The same is also true for the child list.   
Tapping on either person of the “Current Couple XE "Current Couple" ” will display more information about that person.   Tapping on the marriage box will display family information about the “Current Couple”.  Tapping on the spouse and parent icons will display a selection dialog where you can choose a different spouse or set of parents to display.  If the icon is in color, that indicates that additional spouses or parents already exist for that person.
Tip:  The item on the screen that is “selected” will have a darker border.

Tip: XE "Tips"  (Touchscreen devices) You can get a “tip” as to the meaning of each icon by tapping and holding on that icon.  To “cancel” the operation, drag the stylus off the icon before releasing.

Tip: XE "Tips"  You can navigate around the 3-gen screen using the “D-Pad” button or the Action “rocker” switch.   (It depends on your device which type you may have.  The D-Pad button is the 4-way button found on the bottom front of the device.  The Action “rocker” switch is usually found on the left side of the device.)   Either acts like a joystick so that you can move around and select individuals from the 3-gen screen.   You can tell which person is selected as a darker border will appear around the name.  If you “navigate” off the top of the screen, the 3-gen screen will change and you will traverse up one generational level.   The D-Pad button is actually a 5-way switch.  Pressing the button is similar to pressing the “Enter” key on a keyboard XE "Keyboard" .  It is the same as tapping the screen with a stylus for the person who is selected on the 3-gen.
3-Generation XE "View:3-Generation" 

 XE "3-Generation View"  View with Photos
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The 3-Generation (w/Photos) view can be selected from the “Edit”, “View” menu.  It works and looks the same as the regular 3-Gen view but has thumbnail photographs of the ‘preferred’ image for each individual.
Descendant and Ancestor Tree XE "View:Ancestor Tree" 

 XE "View:Descendant Tree" 

 XE "Descendant Tree View" 

 XE "Ancestor Tree View"  View
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 The Descendant Tree XE "View:Descendant Tree" 

 XE "Descendant Tree View"  View (shown) shows the descendants of the current couple.  The Ancestor Tree shows the ancestors of the current couple.  By default, only the first generation is expanded.  Press the “+” button to expand or the “-“ button to contract a branch.    
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There are 4 pieces of information displayed on each line of the tree.

1. The name of the person.

2. The birth/death date of the individual.

3. The sex XE "Sex"  of the individual is represented by the “Male” or “Female” symbol.  Unknown is represented as a question mark.

4. The living XE "Living"  indicator.  If the person is marked as living, the sex XE "Sex"  icon will be in color.  (No living individuals are shown in this example.)

Note: You can also highlight the branch you wish to expand/contract and press the “enter” button on the “D-Pad” to perform that action.
Tip: XE "Tips"  You can set the default “view” shown at startup and the number of levels displayed from the “Edit”, “Configuration XE "Configuration" ”, “View” tab.

If you wish to view or edit the individual information from a Tree View, select the person in the list and press the “Edit” button.   To view/edit the family information, select the individual from the Tree View then press the “Spouse List XE "Spouse List" ” button.   From that list select the spouse for the family in question, then press the “Edit” icon.
Note: You can also highlight the individual in the tree and press the “Select” menu item to view/edit that individual.

Icon Bar buttons

	Button
	Use
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	“Find XE "Find"  Name by Relationship List XE "Relationship List" ” – this is a quick entry into the “Find”, “by Name List” function found on the “Tools” menu.  Selecting this button will show all the immediate relations to the selected individual in the list.  Selecting a person that the relationship list then takes you to the “Find”, “by Name List” function with that person selected.
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	“Edit” – this is used to edit/view the individual selected in the tree.
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	“Parents list” – this icon will show a list of parents for the selected person in the tree.  If more than one set of parents exist, the icon will be in color.   If you select a person from the parent list, they become the new “root” person in the tree.  (Male person by default.)

	[image: image49.jpg]


 [image: image50.jpg]



[image: image51.jpg]


 [image: image52.jpg]



	“Spouse list” – this icon, either female or male, will show a list of spouses for the selected person in the tree.  If more than one spouse exists, then the icon will be in color.  If you select a person from the spouse list, they become the new “root” person in the tree.
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	“Children list” – this icon will show a list of children for the selected person in the tree.  If you select a person from the children list, they become the new “root” person in the tree.
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	“Expand All XE "View:Descendant Tree (Expanding node)" 

 XE "View:Ancestor Tree (Expanding node)" 

 XE "Descendant Tree View:Expanding nodes" 

 XE "Ancestor Tree View:Expanding nodes" ” – this icon will expand all levels for the selected individual.  If you select the “root” person in the list and press this button, all branches of the tree at all levels will be expanded.  Use this with caution as sorting occurs for the children of each level the first time they are expanded.  If you expand all at once, it may take some time to expand depending on the number of individuals and levels.
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	“3 Generation View” – this icon will switch to the “3 Generation” view for the selected person in the tree.
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	“Ancestor Tree XE "View:Ancestor Tree" 

 XE "Ancestor Tree View"  View” – this icon is used to switch to the Ancestor tree view.  If you are already in either tree, the selected individual in the tree becomes the root for the view.  This is handy for quickly navigating up and down a tree.
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	“Descendant Tree XE "View:Descendant Tree" 

 XE "Descendant Tree View"  View” – this icon is used to switch to the Descendant tree view.  If you are already in either tree, the selected individual in the tree becomes the root for the view.  This is handy for quickly navigating up and down a tree.


Individual View XE "View:Individual" 

 XE "Individual View" 
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Unlike the other views that only show a limited number of individuals at a time, the Individual View must read information about all individuals in your database in order to show the display.  Therefore, because of speed considerations, the Individual View is only suitable for small databases.

Note: The Individual View is not currently supported on non-touch screen devices.
Both primary and alternate (AKA XE "AKA" ) names are shown in the view.  Primary name XE "Primary name" s are noted by the use of an asterisk preceding the name.
Note: An asterisk preceding the date indicates that an alternative date was used to signify the birth or death.  (Such as a christening or burial event)   This is true on all views.
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The button and edit field at the top of the view is a means to change the sort XE "Sort"  order of the view as well as navigate (find) the first occurrence of the text that you enter.   Pressing the button will toggle between the fields that are available.   When switching between the fields, the view won’t automatically sort until you tap on the edit field. (which would indicate the intent to enter data.)   Sorting can take from a few seconds to several minutes depending on the size of your database.
You can sort XE "Sort" /find on RIN XE "RIN" , Surname XE "Surname" , Given XE "Given Name"  name, birth or death.   To find the first name in the list with a surname beginning with an “S”, tap on the button until “Surname” appears, then tap on the edit field (which will cause a sort to occur), then enter “S” into the edit field.   If you continue to type, the selected individual in the list will continue to change to match the value entered.   (Typing in “Sma” would position the selection to “*Smart, Sarah” in the example to the right)

Meaning of Icon Buttons in Pocket Genealogist
	Button
	Use (Not all functions are available for all imports)
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	“Address” XE "Address"  - used to invoke the address screen.  If the icon is in color, address information exists for this item.
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	“Add a source citation” XE "Citation (Source)"  – this is used to add a source citation to the current item.  This button is always in color.
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	“List of Source Citations XE "Source Citation" ” – this button display a list of source citations for the current item.   If the book icon is red, source citations exist for the item.
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	“Note” – this is used to display the note screen.  If the icon is in color, a note exists for this item.
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	“Add” – this is used to add an item.
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	“Edit” or “Open” – this is used to edit/view/open an item.
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	“Delete” – this is used to delete an item.
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	“Set to preferred” XE "Preferred"  – this is used to set the selected item to either “primary” or “preferred” (depends on context).
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	“Link to existing Individual” – this is used to link to an existing person such as linking a new child to a set of parents.
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	“Unlink the individual” – this is used to unlink a person such as unlinking a child from a set of parents but not deleting that person.
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	Used to display a relationship list for the current individual.  (Shows parents, spouses, and children of that person).
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	Part of the menu and is used to navigate through the “history” list.  The square box brings up the history list for selection.  The backward and forward buttons move to the previous or next person in the “history” list.
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	“Clear” – this is used to clear the text in the edit field.
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	“Undo” – this is used to reverse the last action or to reset the text (Generally on edit screens).
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	“Find/ XE "Find" Lookup” XE "Lookup"  – this is used to lookup information in the database such as Surnames or Locations.
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	“Save” – this is used to “save” the sort XE "Sort"  order (Legacy XE "Legacy Family Tree"  events for example).
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	“Sort the List” – this is used to “re-order” the list back to its original sequence.  (Legacy XE "Legacy Family Tree"  events, for example)
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	This set of buttons is used to change the order in a list.  (Legacy XE "Legacy Family Tree"  events for example)
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	“Sort Date” – this is used to display the Sort Date. (TMG XE "The Master Genealogist"  Events for example).  When the icon is in color, this indicates a sort XE "Sort"  date exists for the current item.
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	“2nd Date XE "Dates:Ending or Status" ” – depending on import, could be an End Date or a Status Date (such as marriage ending status date).  If the icon is in color, a date exists for the event.
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	“To Do” XE "To Do"  – this is used to display the To Do list.   If the icon is in color, To Do’s exist for the current item.
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	“Latitude XE "Coordinates:Latitude"  / Longitude XE "Longitude (Coordinates)" 

 XE "Latitude (Coordinates)" 

 XE "Coordinates:Longitude" ” – this is used to display latitude and longitude information.  If the icon has a blue background, latitude and longitude values exist for the current item.
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	Used with the “Find by” function to change the character set.
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	“Parents list” – this icon will show a list of parents for the selected person in the tree.  If more than one set of parents exist, the icon will be in color.   A person selected from the parent list becomes the new “root” person in the tree.
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	“Spouse list” – this icon, either female or male, will show a list of spouses for the selected person in the tree.  If more than one spouse exists, then the icon will be in color.  A person selected from the spouse list becomes the new “root” person in the tree.
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	“Children list” – this icon will show a list of children for the selected person in the tree.  If you select a person from the children list, they become the new “root” person in the tree.
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	“Expand All XE "View:Descendant Tree (Expanding node)" 

 XE "View:Ancestor Tree (Expanding node)" 

 XE "Descendant Tree View:Expanding nodes" 

 XE "Ancestor Tree View:Expanding nodes" ” – this icon which is found when in “Tree” view,  will expand all levels for the selected individual.  If you select the “root” person in the list and press this button, all branches of the tree at all levels will be expanded.  Use this with caution as sorting occurs for the children of each level the first time they are expanded.  If you expand all at once, it may take some time to expand depending on the number of individuals and levels.
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	“3 Generation View” – this icon will switch to the “3 Generation” view for the selected person in the tree.
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	“Ancestor Tree XE "View:Ancestor Tree" 

 XE "Ancestor Tree View"  View” – this icon is used to switch to the Ancestor tree view.  If you are already in either tree, the selected individual in the tree becomes the root for the view.  This is handy for quickly navigating up and down a tree.

	[image: image98.jpg]



	“Descendant Tree XE "View:Descendant Tree" 

 XE "Descendant Tree View"  View” – this icon is used to switch to the Descendant tree view.  If you are already in either tree, the selected individual in the tree becomes the root for the view.  This is handy for quickly navigating up and down a tree.
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	“Refresh” XE "Refresh"  – this icon is used refresh the display.  (For example, the “Databases” lists)
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	“Close” – this icon is used to close the currently open database.
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	“Backup” XE "Backup"  – this icon is used to create a backup of the selected database.  
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	“Restore” XE "Restore"  – this icon is used to restore a backup.  This will overwrite the database with the same name on the device.
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	“Add item to Research List” XE "Research List"  – found on Individual, Family, Source, and Repository XE "Repository"  screens and allows you to add that “Item” to a Research List.
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	“Multimedia” XE "Multimedia:Icon"  – this icon is used to display a list of multimedia objects for the current object.  (Individual, event, etc.) 


Individual Information

When you “tap” on either member of the “current couple” in the 3-gen View or press the edit button in one of the other views, you will display a series of tabs with information for that individual.  Depending on the source of the import, since Pocket Genealogist attempts to mirror the capabilities of the desktop genealogy program, you may have a different set of tabs and the information displayed on each tab may have different information.
Main tab (Individual)
[image: image348.png]BROWN, Asa CLARK

[Private
[ Top Secret

DYS19/394
D¥s3zss
Drsaas
Dvssas
Dvs3as
DvssesT




[image: image349.png]


The “Main” tab is used to display the main information about the individual.  This would include the primary name, sex XE "Sex" , a living XE "Living"  indicator and other items.  Some or all of these values may be disabled or hidden depending on the source of the import. 

 or

For some imports, if the database is locked as “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”, the date the individual was last edited on the desktop will be displayed.

For sex and living fields, only the values that can be selected for the particular import will be shown in the list.   (You may only see a single item if the value cannot be changed)

As with most Pocket Genealogist screens, the data displayed and the options available may differ greatly depending on the genealogy program you use on the desktop.  
The “How To” section of this guide goes into much more information.
Names tab (Individual)
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The names tab is used to work with the primary and secondary names for the individual.  Selecting a name in the list then pressing the “edit” button will display the information for that name.  Tapping on any of the name fields will display an edit/view dialog for that name element.  
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Events tab (Individual)
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The events tab, as with most Pocket Genealogist screens, can be greatly different depending on the source of the import.  Some imports may have a drop down list next to a detail field which can be used to change what is displayed in the field.  Depending on the import, you may have roles (witnesses), sort date, address, notes, To Do’s and other fields. Pocket Genealogist uses “profiles” to control this behavior and also will only allow the types of events applicable for the desktop genealogy program you are using.   
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Note:  Primary Events XE "Primary Events" 

 XE "Events:Primary"  (Birth XE "Events:Birth" 

 XE "Birth Event" , Christening XE "Events:Christening" 

 XE "Christening Event" , Marriage XE "Marriage Event" 

 XE "Events:Marriage" , Death XE "Events:Death" 

 XE "Death Event"  and Burial XE "Events:Burial" 

 XE "Burial Event" ) may appear either at the top of the list or be interspersed (usually sorted by date) and will be indicated by an asterisk.   For Family Tree Maker XE "Family Tree Maker"  imports, the Asterisk XE "Asterisk"  indicates the “Preferred XE "Preferred" ” event.
Note: If your desktop program supports witnesses, the events for which the person is a witness will be marked in the list preceded with a “w-“.

Notes tab (Individual)
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The notes tab is for displaying notes about the individual.  Depending on the capabilities of the desktop genealogy program you are using, you may have from zero to many notes.

On the devices that show both the list and the note, the note area may only display partial information.  (Approximately 500 characters)  Tap on the note (or “Edit” from the menu) to display the complete note.

Other devices may show only a list of notes but the entire note can be displayed using the menu.
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Sources XE "Sources"  tab (Individual)
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The sources tab allows you to see all the citations that are attached to all items at the individual level.  The drop down list allows you to pick the type of citations you wish to see in the lists.   
After selecting the item from the first list, the citations for that item will be displayed in the second list.   

On some devices only the first list will be shown and you will need to select an item from the list in order to see a subsequent list with the citations.
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Note: The type of items that appear in the drop down list depends on the capabilities of your desktop genealogy program.

LDS XE "LDS"  tab (Individual)
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The LDS XE "LDS"  Tab is similar to the events tab but is used to display the LDS Ordinances for the individual.   This tab may be hidden if you disable this option from the desktop during import.   In the case of Legacy XE "Legacy Family Tree"  Family Tree direct imports, the display of the tab depends on the options you have set in Legacy.

As with the events tab, you may a drop down list next to a display field which is used to toggle between different types of fields.  In the above example the “Temple XE "Temple" ” field will toggle between “Temple” and “Place XE "Place" 

 XE "Location:Place" ”.

To Do XE "To Do"  tab (Individual)
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The To Do XE "To Do"  tab will be displayed if your desktop genealogy program supports that type of information.  Some desktop programs may support To Do’s but not via GEDCOM XE "GEDCOM"  in which case they will not appear on the device.  As with other screens in Pocket Genealogist, the display will look different based on the import type as in the Legacy XE "Legacy Family Tree"  and TMG XE "The Master Genealogist"  examples above.
Field Notes XE "Field Notes"  tab (Individual)
Field Notes XE "Field Notes"  are available for all imports since they are not specific to a desktop genealogy program.  In fact, information entered here is never transferred back into your desktop program.  Any information you enter can be displayed using the Field Note reporting feature found in the Desktop side of Pocket Genealogist.   How you process the Field Notes is entirely up to you, you may decide to enter them as notes into your desktop program or simply print them for later reference.  See Chapter 7 for additional details on Field Notes XE "Field Notes" .

Note: Since Field Notes XE "Field Notes"  have no direct tie to your desktop genealogy program, every time you import a new database the Field Note tab will always be empty.

DNA XE "DNA"  tab (Individual)
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The DNA XE "DNA"  tab provides a means to view/edit DNA information for the individual.   This feature is only available if supported by your desktop genealogy program.   The type of markers and tests that are displayed depends on the tests supported by your program.

Selecting an item in the list and pressing the “Edit” button will display details for that DNA test.   The “Markers” tab is used to display/edit the DNA markers for the test.
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Identifiers XE "Identifiers"  tab (Individual)
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The Identifiers XE "Identifiers"  tab shows some additional ID fields that may be available for your desktop genealogy program.  

[image: image370.png]



Tip: XE "Tips"  You can set the background color for “Changed data” to one color and editable fields to another.  This can be accomplished from the “Misc Color” tab under “Edit”, “Configuration XE "Configuration" ”.
Relationships XE "Relationships"  tab (Individual)
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The Relationships XE "Relationships"  tab is only available for The Master Genealogist XE "The Master Genealogist"  imports.   This tab shows the relationship information for the individual both backwards (as a child) and forwards (as a parent).
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Misc XE "Relationships"  tab (Individual)
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The “Misc” tab contains miscellaneous information such as the Private indicator.   The availability of the “Misc” tab depends on the features supported by your desktop genealogy program.
Family Information

When you “tap” on the “Marriage XE "Marriage Event" 

 XE "Events:Marriage" ” box in the 3-gen View or select the appropriate edit button or menu item in one of the other views, you will display a series of tabs with information for the “Current Couple XE "Current Couple" ”. The tabs that are displayed are very similar to the tabs found for the Individual.   (See Individual tabs for examples.)
Main tab (Family)

The “Main” tab is used to display details about the union such as the individuals’ names.   It may also have other options and buttons for accessing information attached to the Family record.
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Note: Some imports have the option “All events at individual level” which can be found on the “Customize” screen for the import.   If selected, the family events will not appear at this level but will be shown on the event tab for both individuals that make up the family.
Misc Tab (Family)
The “Misc” tab is used to display miscellaneous information about the family such as “Private” or “Not Married” or married name options.   (Married Name is applicable to Legacy Family Tree only)
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Chapter

4

How to (Desktop) XE "How to:Desktop" 
This chapter goes into detail on how to accomplish various tasks in the desktop side of Pocket Genealogist.

Create a new Pocket Genealogist database XE "Database:Creating" 
Pocket Genealogist is a companion product for desktop genealogy databases.  You cannot use Pocket Genealogist as a stand-alone genealogy program.  You need to have a desktop program where you keep your genealogy data.   To create a new Pocket Genealogist database with the data from your desktop program, use the “Create” Button.  [image: image107.png]


  See “Getting Started (Desktop) XE "Getting Started:Desktop" ” for more details on how to create a new database and synchronize it to the device.

Note: You can have as many Pocket Genealogist databases as you wish from as many different desktop genealogy programs as you use.

Delete a desktop Pocket Genealogist database XE "Database:Deleting (Desktop)" 
If you have a Pocket Genealogist database that you no longer need, you can delete it from the desktop.   This does not automatically delete it from the device so you may want to do the same on the device.   To delete the desktop Pocket Genealogist database do the following:

1. Start Pocket Genealogist on the desktop.

2. Select the database in the list you wish to delete.

3. Press the Delete button.  [image: image108.png]



Perform 2-way Legacy XE "Legacy Family Tree"  Family Tree Synchronization

See Chapter 6 for more details.

Synchronize changes made in your desktop program

With the exception of Legacy XE "Legacy Family Tree"  Family Tree (with 2-way Synchronization enabled), all other imports require a complete re-import of your database when changes are made in your desktop genealogy program.  Please note that all changes made to the database on the device will be replaced with a fresh copy of the database from the desktop.  If you have made changes on the device, always synchronize your database and export the changes to GEDCOM XE "GEDCOM"  before doing a re-import.   See “Re-Import XE "Import" 

 XE "Database:Import"  a database” for more details on how to “refresh” your device database with changes made on the desktop.
Re-import a database XE "Database:Re-importing" 
If you make changes in your desktop genealogy program and want to “Refresh XE "Refresh" ” the device database to reflect these changes, you have to re-import the entire database.   The only current exception is 2-way synchronizations with Legacy XE "Legacy Family Tree"  Family Tree.   Keep in mind that when you re-import a database, any changes you may have made to the database on the device will be replaced by the database on the desktop.  (Think of it as deleting the device database, then creating a new one.)  To re-import your database, do the following steps:
1. Turn on your device and make sure Pocket Genealogist is closed.

2. Connect your device to the desktop and establish an ActiveSync XE "ActiveSync"  connection.

3. Start Pocket Genealogist on the desktop.

4. Select the database you want to re-import from the list.

5. Press the Import XE "Import" 

 XE "Database:Import"  Button.  [image: image109.png]



6. You will get the following warning.   Select “Yes”
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7. A 2nd warning will be displayed verifying you want to overlay the database. Press “OK”.

[image: image111.png]Are you certain you want to do this? Any changes made to the
database on your device will be lost.

() (mCercienl





8. An import screen like the one you originally used for the initial import will be displayed.   You should not need to “Customize” again unless you want to use different options for the type of data that is imported.    Select any options you wish to use such as “2-way Synchronization”  (Legacy XE "Legacy Family Tree"  only) or “Lock Data (View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" )” and then press “Start”.

9. If no errors occurred during import and a synchronization session is established with the device, you will see the “Synchronization” screen.   Don’t forget to pick the location you want to put the database on the device using the drop down list at the top left.   Press “Start” to perform the synchronization. Press “Start” to perform the synchronization.

The database has now been “Refreshed” on the device with the new changes made in your desktop genealogy program. 

Retrieve changes made on the device

You need to do a synchronization in order to retrieve changes made on the device back to the desktop Pocket Genealogist database.  This can be done using the following steps:

1. Turn on your device and make sure Pocket Genealogist is closed.

2. Connect your device to the desktop and establish an ActiveSync XE "ActiveSync"  connection.

3. Start Pocket Genealogist on the desktop.

4. Select the database you want to synchronize from the list.

5. Press the Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization"  Button.  [image: image112.png]



6. A synchronization session will be established to the device.  You will see the synchronization screen both on the desktop and on the device.

7. Press “Start” to perform the synchronization.

8. If you are doing 2-way Legacy XE "Legacy Family Tree"  Synchronizations, additional steps will occur.  See Chapter 6 for more details.

The changes made on the device will now be in the Pocket Genealogist database on the desktop ready for exporting to GEDCOM XE "GEDCOM"  or Field Note/Research List XE "Research List"  processing.

Retrieve “Orphan XE "Orphan (databases)" 

 XE "Database:Orphans" ” databases from the device

When you delete a Pocket Genealogist database on the desktop, it does not automatically delete the database from the device (and Vice Versa).  You can retrieve the database from the device and export the information to GEDCOM XE "GEDCOM"  if you wish.  (VERY handy if you should have a desktop crash and lose your database and backups.)   Databases left on the device but not on the desktop are called “Orphan XE "Orphan (databases)" 

 XE "Database:Orphans" ” databases.  To retrieve an orphan database, do the following:

1. Turn on your device and make sure Pocket Genealogist is closed.

2. Connect your device to the desktop and establish an ActiveSync XE "ActiveSync"  connection.

3. Start Pocket Genealogist on the desktop.

4. Press the “Orphans” button.   If a connection is successful to the device, any “orphaned” databases will now appear in your database lists and the status will indicate if they can be recovered.  If they can, press the Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization"  button [image: image113.png]


 to retrieve the database.

You can now use the Export button to create a GEDCOM XE "GEDCOM"  of your data.  

Note: If this was a Legacy XE "Legacy Family Tree"  database where 2-way synchronizing was enabled, the 2-way synchronizing option will no longer be available.

Set the sound to play after an event XE "Sounds:At completion of an event" 
If you are working with large databases, you may wish to set a “sound prompt” that will play after selected events such as Import XE "Import" 

 XE "Database:Import" , Export, or Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" .   This prompt provides a handy notification when that event is done so you can work on other items.  To set this “sound prompt”, go to the “Options” screen in Pocket Genealogist.
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Pocket Genealogist does not come with any sample sounds, but you can find Windows sounds usually in “C:\windows\media”.   Press the button for the event you wish to set to display a dialog for picking the sound file to play.  Use the “Speaker” button to play the sound for verification.

Change the display language XE "Language:Changing" 
1. Press the “Language” button. [image: image115.png]



2. Select the language you want to use from the list.   “Default” will use the current regional settings to select from the available installed languages.
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“Show All” shows all regional setting values available for the desktop.  Even though you may not have that language available with Pocket Genealogist, the other regional settings such as date format will still be honored.

If you select a language that has not been selected to synchronize to the device, you will get the following prompt:  (The current language is not selected to be synchronized to the device.  Would you like this language to be selected?)
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You will also be given the option to synchronize the language immediately to the device.   If you decline, the next time you do a database synchronization the language will also be synchronized to the device.   

Select language(s) for device  XE "Field Notes" 
You can manually select which languages you want to have synchronized to the device from the “Options”, “Advanced” screen.   Selecting a check box and pressing the “Synchronize” button will add a language to the device.   De-selecting a check box and synchronizing will remove the language from the device.
If you do not explicitly synchronize the languages from this screen, they will automatically be synchronized during database synchronization.

Export device changes to GEDCOM XE "GEDCOM:Exporting" 

 XE "Exporting to GEDCOM" 
After performing a synchronization to retrieve changes made on the device (see “Retrieve (Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ) Changes made on the device”), you can export the data to a GEDCOM XE "GEDCOM"  file which can be used by your desktop genealogy program.   You may wish to load the GEDCOM as a new database or “merge” the data with your current database.   (See your desktop genealogy programs’ help file for more information on how to accomplish that.)  To create a GEDCOM do the following steps:

1. Make sure you’ve synchronized the changes from the device first.

2. Select the database from the list in Pocket Genealogist on the desktop.

3. Press the Export button.  [image: image118.png]



4. Select GEDCOM
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5. If the import for this database was a GEDCOM XE "GEDCOM"  file, you will be prompted if you wish to replace the original GEDCOM.    

[image: image120.png]L L —





Warning: For Family Historian XE "Family Historian" , which uses GEDCOM XE "GEDCOM"  as its “database”, replacing the original GEDCOM would be replacing your FH database.   You should probably not use this option.

6. The Export to GEDCOM XE "GEDCOM"  screen will be displayed.  If the name and location of the GEDCOM file is blank, you will need to press the “Select” button to pick a location and name you wish to use.

7. If you want to keep the size of the GEDCOM XE "GEDCOM"  file to a minimum, which may be a good idea if you plan on doing a “merge” with your desktop program, select the “Only Individuals with changes”.   All information for that Individual will be exported, but only for those individuals where a change has occurred.   If it would be helpful during “merge”, you can also include spouses, children and parents of Individuals with changes.

8. Press “Start” to export the GEDCOM XE "GEDCOM" .

You can now use the GEDCOM XE "GEDCOM"  file as input into your desktop genealogy program.

Note: GEDCOM XE "GEDCOM"  files that were originally imported as “ANSI XE "ANSI" ”, “UTF-8 XE "UTF-8" ”, or UNICODE will by default be exported in the same format.   “ANSEL XE "ANSEL" ” coded GEDCOM files will be exported as “ANSI”.     You can change the format of the output on the Export screen.

Note: You can create GEDCOM XE "GEDCOM"  files for direct Legacy, The Master Genealogist XE "Legacy Family Tree"  or for the “PAF/FTM add-on” data although not all information may be eligible for output to GEDCOM (for example, TMG XE "The Master Genealogist"  Roles).

Note: It is recommended that you import the GEDCOM XE "GEDCOM"  file into a new database in your desktop genealogy program until you get comfortable with the process of merging data into your original database.
Process Field Notes (from device) XE "Field Notes:Processing" 

 XE "Processing Field Notes" 
After performing a synchronization to retrieve changes made on the device (see “Retrieve (Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ) Changes made on the device”), you can process the field notes made on the device.  (For example, you may wish to cut and paste them into your desktop genealogy program, or print them for later use)

1. Make sure you’ve synchronized the changes from the device first.

2. Select the database from the list in Pocket Genealogist on the desktop.

3. Press the Export button.  [image: image121.png]



4. Select “Field Notes”
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See Chapter 7 for additional details on what you can do with the Field Notes XE "Field Notes" .

Process Research Lists (from device) XE "Research List:Processing" 

 XE "Processing Research List" 
After performing a synchronization to retrieve changes made on the device (see “Retrieve (Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ) Changes made on the device”), you can process the research lists made on the device. 

1. Make sure you’ve synchronized the changes from the device first.

2. Select the database from the list in Pocket Genealogist on the desktop.

3. Press the Export button.  [image: image123.png]



4. Select “Research List” 
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See Chapter 8 for additional details on what you can do with the Research List XE "Research List"  display.
Process Changes Report (from device) XE "Changes Report:Processing" 

 XE "Processing Changes Report" 
After performing a synchronization to retrieve changes made on the device (see “Retrieve (Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ) Changes made on the device”), you can retrieve and print changes made to the database on the device.

1. Make sure you’ve synchronized the changes from the device first.

2. Select the database from the list in Pocket Genealogist on the desktop.

3. Press the Export button.  [image: image125.png]



4. Select “Changes made on the device” 
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See Chapter 9 for additional details.

Remove customization values
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There are times when you may wish to reset the customization values or delete all databases on the desktop side of Pocket Genealogist.   Start Pocket Genealogist on the desktop and press the “Tools” button.  There are four types of data that can be removed.
1. Databases – selecting this option will delete all Pocket Genealogist databases on the desktop.  It does not delete databases on the device.

2. Configuration XE "Configuration"  – this removes all customization values such as the type of data you’ve selected for import, your registration/unlock code, the size and position of columns in lists and other customization information.   Removing these values will allow you to re-select the location where databases are stored.
3. Logs – this will remove all Pocket Genealogist log files.

4. GEDCOM XE "GEDCOM"  Profiles – if you have modified GEDCOM Profiles (not generally recommended), selecting this option will remove the customized profiles and reset the system back to the default profiles.

After selecting the options to remove, press the “Remove” button.  Pocket Genealogist will exit after you press this button.

Set the default path for an Import XE "Import" 

 XE "Database:Import" 
When you do imports of a particular type (for example GEDCOM XE "GEDCOM" ), the default location on your computer where it will look for this type of file is saved within Pocket Genealogist.   If you change the location at import time, you will be prompted if you want to set the new location as the default path. 
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Press the button for the path you wish to set and a Windows selection dialog will be displayed to allow you to pick the path.

Resize a list column XE "Lists:Column Width" 
Most lists in Pocket Genealogist will allow you to resize the columns in the list.   Move your mouse over the vertical bar that separates the column header for the column you wish to resize, then hold down the left mouse button and move the mouse to resize the column.   Double clicking on the vertical bar between columns will automatically resize the column to the width of the header text.
Change the column order of lists XE "Lists:Column Position" 
Most lists in Pocket Genealogist will allow you to change the order of the columns.  Using the mouse, single left click on the column header you wish to move and hold down the mouse.  Then drag the column to the location in the list where you wish to place it.
Save List Column Widths and Position
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 Most of the lists in Pocket Genealogist allow you to resize the columns and set the order of the columns as you choose.   If you want to automatically save the changes you make so that each time you start Pocket Genealogist, turn on this default from the “Options” button.   See “Resize a list column XE "Lists:Column Width" ” and “Change the column order of lists XE "Lists:Column Position" ” for details on how to make those changes.
Tip: XE "Tips"  Change the lists to how you like them then turn off this option so that you don’t accidentally change the list later.

Tip: XE "Tips"  You can reset the column width and order for all lists by first turning on this option, then turning it off.  The prompt will ask if you want to reset to the default.
Set “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ” as the default
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If you want the majority of your Pocket Genealogist databases to be “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”, you can set this as the  XE "Import" 

 XE "Database:Import" default from the “Options” Screen.   You can still override this value during import.
Note: Setting this option has no effect on previously imported/synchronized databases.
Enter your registration (unlock) code

When you run Pocket Genealogist for the first time, you will be prompted for your registration code.  If you didn’t enter it at that time or need to re-enter the code later,  for example when you upgrade from “Basic” to “Advanced”, you can enter it from the “About” screen.
Change the code page

In rare cases you may need to change the code page used during imports.  (For example if you are using the Greek alphabet or the Vietnamese character set.)   You can change the default code page from the “Advanced” screen found under “Options”.    Use the “Default” button to set the code page back to the default.
Note: It is recommended that you do not change this value without first talking to Pocket Genealogist support.

Use TCP/IP XE "TCP/IP"  as the synchronization method

If you are having firewall problems and are unable to get synchronization working with Pocket Genealogist (“Unable to Communicate” message) or are using Wi-Fi or an Ethernet connection with a Windows Mobile 5 or 6 device XE "Windows Mobile 5 or 6" , you may need to turn on the “Use TCP/IP XE "TCP/IP"  for communications” option.   You can find this on the “Advanced” screen under “Options”.    Non-Touchscreen devices may also need to have this option turned on in order to synchronize.
Select type of data to import
When you import a database, you have options on the type of data that you can send to the device.  You can use this to minimize the sync time to the device or to conserve space.    Use the “Customize” button found on the import screen to set the options.
Set the database to “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”
When you do an import from your genealogy database, you can set the Pocket Genealogist database to “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”.   You may wish to do this if you aren’t planning on making changes on the device as it will prevent accidental changes.  You can set this option on the import screen during synchronization.
Enabling 2-way Synchronizations

With Legacy XE "Legacy Family Tree"  Family Tree databases, you may want to enable 2-way Synchronizations.  This will allow you to make changes on the device, then directly update your Legacy database during synchronization.   You can enable this option from the import screen.   See Chapter 6 for more details.

Create a GEDCOM XE "GEDCOM"  file for Import XE "Import" 

 XE "Database:Import" 
If you are using a GEDCOM XE "GEDCOM"  file as input into Pocket Genealogist, you must first create the file from your desktop genealogy program.   See Appendix B for some examples on how to create this file.
View a Pocket Genealogist Log XE "Logs:Pocket Genealogist" 
The bottom half of the Pocket Genealogist “main” window contains information about actions you have taken during the current Pocket Genealogist session.   You can also see the last 7 days worth of sessions by opening the Pocket Genealogist log window.  

Press the “Logs” button [image: image128.png]


 to open a window where you can select any of the last 7 days of logged sessions.  Select an item in the list and press “Open”.  A separate window (generally Windows Notepad) will open with the log information.

Search for your Desktop Genealogy data (Import)

See the “Getting Started (Desktop)” chapter for information on how to search for your desktop genealogy data when creating a new Pocket Genealogist database.
(This page intentionally left blank)
Chapter

5

How to (Device) XE "How to:Device" 
This chapter goes into detail on how to accomplish various tasks on the device side of Pocket Genealogist.
Interacting with device: Touchscreen vs. Non-Touchscreen
Pocket Genealogist supports a wide range of devices including Smartphones (both touchscreen and non-touchscreen) and PocketPC’s.   Some touchscreens will also be “capactive” and are designed to be used with a finger instead of a stylus.
Touch screen Interaction
The common method of interacting with touch screen devices is with the included stylus.  However, there are other ways to interact that bypass the use of the stylus.
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Directional Pad (D-Pad):  This is a 5-way “rocker” button and acts similar to a joystick.   You can move around on the screen by pressing the button up, down, right or left.   Pressing the center of the button acts like an ‘Enter’ key or the equivalent of a “tap”.
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Menu Buttons: On all screens except the main “views” (3-gen View for example) there will be a two item menu at the bottom of the screen.  Pressing the left or right menu button will invoke the left or right menu item.  You may need to enable this on your device at “Start”, “Settings”, “Buttons”.   (Assign “Left Softkey” to button 1 and “Right Softkey” to button 4)
Non-Touchscreen Interaction
Some smartphones do not have a touch screen.   They depend heavily on the use of the directional pad (D-Pad), menu buttons and keypad.

1. [image: image381.png]BROWN, Asa CLAR

[Names <

Secondary  sa Clark
Seondsry  Clrk




Directional Pad (D-Pad):  This is a 5-way “rocker” button and acts similar to a joystick.   You can move around on the screen by pressing the button up, down, right or left.   Pressing the center of the button acts like an ‘Enter’ key or the equivalent of a “tap” on the screen.  You can use the D-Pad to move to other items on the display such as the parents or children.  Pressing the D-Pad (“Enter”) will cause the parent or child to move to the “Current Couple” position.
2. Menu Buttons: On all screens there will be a two item menu at the bottom of the screen.  Pressing the left or right menu button will invoke the left or right menu item.   On the 3-gen example to the left, the detail information for the left “current couple” person (Asa Brown) will be displayed if you press the left menu button.  (That position is “highlighted” indicated by the darker border)  Additionally, if you move to a parent or child and press the left menu button (“Select”), you can view that individuals details without making them the “Current Couple”.
“Tab” display
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Non-Touchscreen devices do not support the “tab” display like what you see on Touchscreen devices. Instead, there will be a selection field at the top of each detail screen that allows you to switch between the various “tabs”.
Whenever you display a “tab” screen, the “focus” (cursor) will always be on the “switch” field.   You can use the left and right button of the D-pad to change which “tab” is shown or you can press the D-Pad “Enter” on the field to display a list of all “tabs” that you can select from.   The ability to show a list of available values is true for all fields that show a left and right arrow.    Pressing “Enter” on fields that don’t have the arrows will invoke the Pocket Genealogist “edit” screen applicable for that field.
Tip: The field that is currently selected on the screen will have a border around it to help distinguish that it has the “focus”.    When you move off the field the border will disappear.
Most Pocket Genealogist Non-Touchscreen screens are larger than what can be displayed at once and will have a scroll bar to the right.   Use the D-Pad up/down button to move between the fields which will automatically scroll as necessary.    Even when more than one field is shown on a single line, you always use the up/down button to move between fields.    The left/right button is used to move within a single field or to change the selection of fields that have the arrow buttons.    One exception are “lists” such as the event list.   When you move the selection up or down in the list to find the item you wish to have selected, use the left and right button to move away from the list and keep the selection.

Displaying Individual Information
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Touchscreen: From the 3-gen screen, tap the left or right “Current Couple” person to display more information about that individual.   From the other views, select the person in the list or tree and press the “Edit” button. 
Non-Touchscreen: Use the “Select” menu item once you highlight an individual on the view.
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Displaying Family Information
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Touchscreen: From the 3-gen screen, tap the marriage box to display more information about that Family.   From the tree views or the Individual list, select the person, press the spouse button, then select the spouse in the list and press “Edit”.   

Non-Touchscreen: Use the “Select” menu item after you highlight the marriage box on the 3-Gen view.  From the other views use the “menu” button to find the means to view the family information.

[image: image386.png]BROWN, Asa CLARK
Type:
FPrimary

Prefix

Given:
Asa CLARK

Surname:





Displaying “General” Information
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Information that is not attached to an Individual or a Family, for example “General” To Do XE "To Do" ’s in Legacy XE "Legacy Family Tree" , can be found from “Edit”, “General Details”.    This is also the location where general Field Notes XE "Field Notes"  and all Research List XE "Research List"  items can be found.
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Editing data

The data in Pocket Genealogist is never edited “in place”.   When you see a screen displayed with information, tapping on the data field, using the D-Pad “Enter”, or using the space bar (if you have a keyboard) will bring up a view/edit screen that will allow you to change the information.   This allows the program to customize how fields are edited,  depending on the type of field and the capabilities of the desktop genealogy program.   The view/edit screen may have additional features such as the ability to look up information in the database or to reset the field to an empty value.
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In this Touchscreen example, tapping on the date field will bring up the view/edit screen for dates.
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In this Non-Touchscreen example, use the up/down button to “highlight” the field you wish to edit, then press the D-Pad “Enter” to invoke the edit screen for that field.
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Add a new Person XE "Spouse:Adding" 

 XE "Parents:Adding" 

 XE "Child:Adding" 

 XE "Adding:Daughter" 

 XE "Adding:Son" 

 XE "Adding:Unrelated Individual" 

 XE "Adding:Sister" 

 XE "Adding:Spouse" 

 XE "Adding:Parent" 

 XE "Adding:Child" 

 XE "Adding:Brother" 

 XE "Add a new Person"  
Touchscreen
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The “Add Person” screen greatly simplifies adding new individuals by displaying a graphical representation of individuals related to the selected person.   To access this screen use the menu item “Edit’, “Add Person”.

Tip: XE "Tips"  On Touchscreen devices, use “Tap and Hold XE "Tips:Icon" 

 XE "Tap and Hold:Tips" ” on the buttons to get more information about the icon.  This example shows a “Tap and Hold” on the Brother button.
There are buttons for adding parents, siblings, spouses, children or an unrelated individual.  

You can also add individuals from the spouses, parents, and children screens.   

	Children
	On the “Edit”, “Children” screen, use the “Add” button to add a new child.  

	Spouses
	Use the icons on the 3-gen screen to display all spouses for an individual or use the “Edit”, “Spouses” menu item to display the spouse list.  Use the “Add” button to add a new spouse.  You can also Link an existing person in the database as a spouse instead of creating a new person.

	Parents
	Use the icons on the 3-gen screen to display all parents for an individual or use the “Edit”, “Parents” menu item to display the spouse list.  Use the “Add” button to add a new parent set.


Non-Touchscreen 

The “Add Person” screen is found from “Menu”, “Edit”, “Add Person”.   Select the type of person you wish to add from the selection list.
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Add an Event
Touchscreen XE "Events:Adding" 

 XE "Adding:Event" 
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Press the ‘Add’ button [image: image130.jpg]


 on the “Events” tab or “New” from the menu to add a new event.   A list of available events will be displayed.  (The list will differ depending on the desktop genealogy program you use.)   Primary events will appear at the top of the list followed by all other events in alphabetical order. Select the event in the list that you wish to add and press “OK”.    
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The event will be added to your database and you can then add a date, place, memo, etc. to the event.   (As with most fields in Pocket Genealogist, you edit/view individual fields by tapping on the field or by pressing the space bar if you have a keyboard XE "Keyboard" .)

See “Working with Dates XE "Working with Dates" 

 XE "Dates:Working with" ” for an example of what happens when you tap on the date field.
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Square screen and Landscape devices do not show the event details on the event tab.  Select the event you wish to edit/view and press the “Edit” button.

Non-Touchscreen
Add a new event using the menu.  Select the type of event from the list and it will be added to the event list and you will be automatically taken to the detail screen for editing.
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Add a Source XE "Sources:Adding" 

 XE "Adding:Source"  Citation
Touchscreen XE "Source Citation:Adding" 

 XE "Adding:Source Citation" 
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You’ll find source buttons on screens where citations are allowed for the type of item you are looking at.  There are always two buttons:
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 Source Citation XE "Source Citation"  Add – use this button to add a source citation XE "Citation (Source)" .   The tabbed dialogs that appear will allow you to enter the citation information as well as select the source to go with the citation.   You can also add an entire new source from these screens.
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 Source Citation XE "Source Citation"  List – this button is used to display the source citation XE "Citation (Source)"  list for the item you are viewing (such as an event).   The button is gray which indicates that no citations are currently attached to this item.  You can add a new Citation using the “Add” button. [image: image133.jpg]



OR
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 Source Citation XE "Source Citation"  List – the button is “Red” indicating that there is already at least one source citation XE "Citation (Source)"  in the list for this item.

Non-Touchscreen
You will find menu items on the screens that allow source citations.
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Note: See also “Add a Source” which goes hand in hand with adding a citation.

Add a Source
Touchscreen XE "Sources:Adding" 

 XE "Adding:Source" 
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When adding a Source Citation XE "Source Citation" , either tap on the “Source” tab or use the “Select Source” button to select a source.   The “Select source” screen can be used to pick an existing source or to add an entirely new source by pressing the “Add” button.[image: image135.jpg]
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After the new source is created, all fields will be empty except for the “Abbrev” field which will have the value “<< New >>”.

Non-Touchscreen
You can either switch to the source “tab”, or use the menu to select the source when creating a new citation.  You can use the list to select an existing source or create a new one from the menu.
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Add a Note
Touchscreen XE "Notes:Adding" 

 XE "Adding:Note" 
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If notes are allowed for an Individual or Family, a “Notes” tab will be displayed when viewing the Individual or Family information.    
[image: image136.jpg]


 Other items such as Events will have a “Note” button for accessing the note.  (A gray icon means there is no note and a red icon indicates the presence of a note.)   
With devices that show both a list and a note area, the note may only partially be displayed.   Tap on the note area or use the “Edit” icon to display the entire note.
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	Add another Note.

	[image: image138.jpg]



	View/Edit the complete note.

	[image: image139.jpg]



	Delete the note.


Non-Touchscreen
If notes are allowed for an individual or Family, a “Notes” tab will be available for display.   Other items such as events will have a “Notes” menu item that will be enabled if notes are allowable.
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Note: When viewing the entire note, if the note is larger than 30,000 characters you will be asked if you wish to view it in “Read Only” mode.   Large notes can be very slow to display and read only mode can make things faster.

Add an Address
Touchscreen XE "Address:Adding" 

 XE "Adding:Address" 
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 The “Address XE "Address" ” button will be displayed for items that allow addresses.   Pressing the button will display a screen where you can enter the address information.    As with most icons, if the button is in color it represents the presence of an address.  If gray it indicates the absence.

[image: image412.png]/|

Compler [ To o] Resarch st | P s




The Address XE "Address"  screen may look vastly different depending on the capabilities of your desktop genealogy program.
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	Use this button to delete the entire address.

	[image: image142.jpg]



	Use this button to find and use an existing address.
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	Use this button, if supported by your desktop genealogy program, to enter latitude/longitude information.
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	Use this button to enter the address note.


Tip: XE "Tips"  For Individual and Family addresses, look for the address button on the “Main” tab.

Non-Touchscreen
If addresses are allowed for an item such as an individual, family or event, the “Address” menu item will be enabled. 
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Add a To Do
Touchscreen XE "To Do:Adding" 

 XE "Adding:To Do" 
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A To Do XE "To Do"  can be attached to Individuals, Families, Events, Sources XE "Sources" , etc.  The To Do tab will appear for Individuals and Families if supported by your desktop program.   You may also see a To Do button  on screens such as the Event tab.
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	Invoke the To Do XE "To Do"  screen for the selected item – There are no To Do’s currently defined for this item.

	[image: image146.jpg]



	Invoke the To Do XE "To Do"  screen for the selected item – To Do’s already exist.


To Do XE "To Do" ’s already defined for the item will be in the list and selecting that To Do will allow you to view/edit or delete it.   Pressing the Add button allows you to create a new To Do.   The type of data fields shown on the To Do edit screens will greatly differ depending on your desktop program.   For those imports that allow a single To Do to be attached to multiple items, such as The Master Genealogist XE "The Master Genealogist" , the “Reference” tab will give you those details.
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Non-Touchscreen
A To Do XE "To Do"  can be attached to Individuals, Families, Events, Sources XE "Sources" , etc. The To Do “tab” will appear for Individuals and Families if supported by your desktop program.   For items that support To Do’s such as events, a “To Do” menu item will be enabled if supported by your desktop program.
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Add an item to a Research List XE "Research List:Adding" 

 XE "Adding:Research List item" 
Research List XE "Research List" s can be viewed from the “General Details” display.  See Chapter 8 for more details on working with Research Lists.
Add a Field Note XE "Field Notes:Adding" 

 XE "Adding:Field Note" 
Field Notes XE "Field Notes"  are very similar to notes transferred from your desktop genealogy program.  However, Field Notes are not part of your original data and they cannot be transferred back to your original data via 2-way synchronizing or GEDCOM XE "GEDCOM" .   Field Notes entered on the device can be synchronized back to the desktop then “processed” using the Report function.   See Chapter 7 for more details.
Add a Secondary (AKA) Name
Touchscreen XE "Name:Adding secondary" 

 XE "Name:Adding an AKA" 

 XE "Adding:Secondary Name" 

 XE "Adding:AKA" 
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The desktop genealogy programs use different terms for “Secondary Names” but the concept is the same in Pocket Genealogist.  Go to the “Names” tab for the Individual and press the “Add” button to add a new Secondary name.
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	Add a name
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	Delete a name


Non-Touchscreen
The desktop genealogy programs use different terms for “Secondary Names” but the concept is the same in Pocket Genealogist.  Go to the “Names” tab for the Individual and use the menu to add or delete names.
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Note: You cannot delete the Primary name XE "Primary name"  from the list. 

Note: Not all desktop genealogy programs allow secondary names.

Swap a Secondary name with the Primary XE "Name:Swapping" 
Touchscreen
[image: image423.png]


You can “swap” a secondary name with the primary name in Pocket Genealogist.   Select the secondary name you wish to become the primary name and press the “Set to Preferred XE "Preferred" ” button.

Non-Touchscreen
Select the secondary name in the list to set to preferred, then use the menu to do it.
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Add a DNA Test
Touchscreen XE "DNA:Adding" 

 XE "Adding:DNA" 
If your desktop program supports DNA XE "DNA"  tests, including the ability to transfer it via GEDCOM XE "GEDCOM" , a DNA tab will appear as part of the Individual information.  Press the “Add” button [image: image149.jpg]


 to display a list of tests that you can select.    After a test has been added to the list use the “Edit” button to change the information for that test.
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Non-Touchscreen
If your desktop program supports DNA XE "DNA"  tests, including the ability to transfer it via GEDCOM XE "GEDCOM" , a DNA tab will appear as part of the Individual information.  You can add a new test using “New” on the menu.   Selecting an item in the list and using “Edit” from the menu will display the markers which you can then edit.
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Add a new Location
Touchscreen XE "Location:Adding" 

 XE "Adding:Location" 
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You can view/edit the location for an event by tapping on the Place XE "Place" 

 XE "Location:Place"  field when displaying the event.   The Location view/edit screen allows you to look up locations already defined in the database using the “Lookup XE "Lookup" ” [image: image150.jpg]


 button.  Alternately, you can type in the name of the location.   If the location does not exist in the database, a prompt asks if you would like to add it.
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	[image: image151.jpg]



	Clear the field
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	Undo last change
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	Lookup XE "Lookup"  a location
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	View/Edit the Latitude/ XE "Coordinates:Latitude" Longitude XE "Longitude (Coordinates)" 

 XE "Latitude (Coordinates)" 

 XE "Coordinates:Longitude" 
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	View/Edit the Location Note
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If you use the “Lookup XE "Lookup" ” [image: image156.jpg]


 button, the current location will be shown in the lookup list, and you can see how many references in the database there are for that location.   Use the keys at the top to find locations starting with that letter.  Select an item in the list and press “OK” to select that location.
Non-Touchscreen
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You can view/edit the location for an event by pressing the D-Pad “enter” button after scrolling down to the place field.  The Location view/edit screen allows you to look up locations already defined in the database using the “Find” menu item.  Alternately, you can type in the name of the location.   If the location does not exist in the database, a prompt asks if you would like to add it.
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If you use the “Find” menu item XE "Lookup" , the current location will be shown in the lookup list, and you can see how many references in the database there are for that location.   Use the selection list to find locations starting with the value you select.  Select an item in the list and press the D-Pad “Enter” to select that location.

Add a new Surname
Touchscreen XE "Surname:Adding" 

 XE "Adding:Surname" 
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You can edit the surname of an individual by tapping on the Surname XE "Surname"  field.   The Surname edit screen allows you to look up surnames already defined in the database using the “Lookup XE "Lookup" ” button.   If you type in a surname that does not exist in the database, a prompt asks if you would like to add it. 
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	Clear the field
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	Undo last change
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	Lookup XE "Lookup"  a surname


Non-Touchscreen
You can edit the surname of an individual by pressing the D-Pad “enter” button after scrolling down to the Surname field.  The Surname edit screen allows you to look up surnames already defined in the database by using the “Find” menu item. XE "Lookup"   If you type in a surname that does not exist in the database, a prompt asks if you would like to add it.
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Add a new Prefix
Touchscreen
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When you tap on the prefix field for a name, you will be shown a list of prefixes already defined in the database.   The prefix currently selected for the name will be highlighted in the list.  A new prefix can be added to the database by pressing the “Add” button.

Select from the list the prefix you want to assign to the name and press “OK”.
Non-Touchscreen
Press the D-Pad “enter” button on the prefix field for the  name to display a list of prefixes defined in the database.   The prefix currently selected for the name will be highlighted in the list.   A new prefix can be added to the database using the “New” menu item.
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Add a new Suffix XE "Suffix:Adding" 

 XE "Adding:Suffix" 
Works the same as the prefix field.
Link an existing Individual as a spouse
Touchscreen XE "Spouse:Linking" 

 XE "Linking:Spouse" 
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The “Add Person” screen invoked from the “Edit” menu is useful for adding new individuals but cannot be used to link an existing person as a spouse to another.  
Instead use the “Spouse List XE "Spouse List" ” screen to work with spouses of an Individual.  

[image: image160.png]


 or [image: image161.png]


 (from the 3-Gen screen for example) to invoke the “Spouse List XE "Spouse List" ” or use the main “Edit” menu.
[image: image162.jpg]


 to link to an existing person.  A “Find XE "Find" ” list will be displayed so you can select the person you want to link as a spouse.
Non-Touchscreen
The “Add Person” screen invoked from the “Edit” menu is useful for adding new individuals but cannot be used to link an existing person as a spouse to another.  

Instead use the “Spouse List XE "Spouse List" ” screen to work with spouses of an Individual.  

[image: image163.png]


 or [image: image164.png]


 (from the 3-Gen screen for example) to invoke the “Spouse List XE "Spouse List" ” or use the main “Edit” menu.

Then use the “Link to Existing…” menu item to link to an existing person.  A “Find XE "Find" ” list will be displayed so you can select the person you want to link as a spouse.
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Link an existing Individual as a child
Touchscreen XE "Linking:Child" 

 XE "Child:Linking" 
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The “Add Person” screen invoked from the “Edit” menu is useful for adding new individuals but cannot be used to link an existing person as a child to parents.

Instead use the “Children List XE "Children List" ” screen to work with children for a couple.   

[image: image165.jpg]


 to invoke the “Children List XE "Children List" ” or use the “Edit” menu.
[image: image166.jpg]


 to link to an existing person.  A “Find XE "Find" ” list will be displayed so you can select the person you want to link as a child.

Non-Touchscreen
The “Add Person” screen invoked from the “Edit” menu is useful for adding new individuals but cannot be used to link an existing person as a child to parents.

Instead use the “Children List XE "Children List" ” screen to work with children for a couple.   Use the “Edit”, “Children” menu item to view the child list.  Then use the “Link to Existing…” menu item to link to an existing person.  A “Find XE "Find" ” list will be displayed so you can select the person you want to link as a child.
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Link an existing Individual as a parent XE "Parents:Linking" 

 XE "Linking:Parents" 
The “Add Person” screen invoked from the “Edit” menu is useful for adding new individuals but cannot be used to link an existing person as a parent to another.  You can’t link parents from the “Parents List XE "Parents:List" ” either.  To add a new parent using an existing person in the database, go to the person who will become the parent and add the other person as a child.

Delete a spouse XE "Spouse:Deleting" 

 XE "Deleting:Spouse" 
When you do a deletion on a spouse, you are not only removing that person as a spouse, you are also deleting that person from the database.   (See “Unlink a Spouse” if you don’t want to delete them from the database.)    
[image: image167.png]


 or [image: image168.png]


 to Invoke the “Spouse List XE "Spouse List" ” or use the “Edit” menu.

Touchscreen
[image: image169.jpg]


 Select the person in the list and press the “Delete” button.  The immediate relations to that person will be displayed so you can verify first before deleting.

Non-Touchscreen
Select the person in the list and use the “Delete” menu item.  The immediate relations to that person will be displayed so you can verify first before deleting.

Delete a Parent XE "Parents:Deleting" 

 XE "Deleting:Parent" 
You can’t directly delete parents from an individual, but you can “unlink” those parents from that person.  (See “Unlink a parent XE "Unlink:Parent" 

 XE "Parents:Unlinking" ”.)    To indirectly delete one or both parents, make the parents the “Current Couple XE "Current Couple" ”, then delete either spouse using the “Edit” menu.  Deleting an individual will remove them from the database.  
Delete a child
Touchscreen XE "Deleting:Child" 

 XE "Child:Deleting" 
[image: image447.png]Brown, Asa Cla

Reference <« I




Use the “Children List XE "Children List" ” to delete a child from a couple.  Deleting a child will remove not only the child reference, but that individual from the database.   If you only wish to remove the child reference, see “Unlink a child XE "Unlink:Child" 

 XE "Child:Unlinking" ” instead.   
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 to invoke the “Children List XE "Children List" ” or use the “Edit” menu.
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 Select the person in the list and press the “Delete” button.  The immediate relations to that person will be displayed so you can verify first before deleting.

Non-Touchscreen
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Use the “Children List XE "Children List" ” to delete a child from a couple.  Deleting a child will remove not only the child reference, but that individual from the database.   If you only wish to remove the child reference, see “Unlink a child XE "Unlink:Child" 

 XE "Child:Unlinking" ” instead.   

Use the “Edit”, “Children” menu item to invoke the “Children List XE "Children List" ”.
Select the person in the list then use the “Delete” menu item.  The immediate relations to that person will be displayed so you can verify first before deleting.

Unlink a spouse
Touchscreen XE "Unlink:Spouse" 

 XE "Spouse:Unlinking" 
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You can remove a spouse from an individual yet not delete that spouse from the database.   If you with to delete the spouse, see “Delete a spouse XE "Spouse:Deleting" 

 XE "Deleting:Spouse" ”.  

[image: image172.png]


 or [image: image173.png]


 to invoke the “Spouse List XE "Spouse List" ” or use the “Edit” menu.

[image: image174.jpg]


 Select the spouse you wish to remove and press the “Unlink” button.   You will get a yes/no prompt before the action is performed.

Non-Touchscreen
You can remove a spouse from an individual yet not delete that spouse from the database.   If you with to delete the spouse, see “Delete a spouse XE "Spouse:Deleting" 

 XE "Deleting:Spouse" ”.  

[image: image175.png]


 or [image: image176.png]


 from the 3-Gen view to invoke the “Spouse List XE "Spouse List" ” or use the “Edit” menu.

Select the spouse you wish to remove then use the “Unlink” menu item.   You will get a yes/no prompt before the action is performed.
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Unlink a parent
Touchscreen XE "Unlink:Parent" 

 XE "Parents:Unlinking" 
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You can unlink a set of parents or an individual parent from a person without deleting them from the database.   If you wish to delete the parents, see “Delete a parent”.    

Unlinking both parents

 [image: image177.jpg]


 to display the “Parents list” or use the “Edit” menu.
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 Select the parents you wish to remove and press the “Unlink” button.
Non-Touchscreen
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You can unlink a set of parents or an individual parent from a person without deleting them from the database.   If you wish to delete the parents, see “Delete a parent”.    

Unlinking both parents

 [image: image179.jpg]


 Use the parents button from the 3-Gen view to display the “Parents list” or use the “Edit” menu.

Select the parents you wish to remove then use the “Unlink” menu item. 

Unlinking one parent

To unlink just one parent, make the parents the current couple and unlink the parent using information found under the topic “Unlink a spouse XE "Unlink:Spouse" 

 XE "Spouse:Unlinking" ”.

Unlink a child
Touchscreen XE "Unlink:Child" 

 XE "Child:Unlinking" 
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You can remove a child from a set of parents without deleting them from the database.   If you wish to delete the child, see the topic “Delete a child XE "Deleting:Child" 

 XE "Child:Deleting" ”.    
[image: image180.jpg]


 Use this icon to go to the “Children List XE "Children List" ” or use the “Edit” menu.  

[image: image181.jpg]


 Select the child from the list you wish to unlink and press the “Unlink” button.  You will get a yes/no prompt before the action is performed.
Non-Touchscreen
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You can remove a child from a set of parents without deleting them from the database.   If you wish to delete the child, see the topic “Delete a child XE "Deleting:Child" 

 XE "Child:Deleting" ”.    

Use the “Edit”, “Children” menu item to invoke the “Children List XE "Children List" ”.

Select the child from the list you wish to unlink and then use the “Unlink” menu item.  You will get a yes/no prompt before the action is performed.

Change Order of Children
Touchscreen
[image: image456.png]


With some imports, you can change the order of the children.   
[image: image182.jpg]


 to go to the “Children List XE "Children List" ” or use the “Edit” menu.

[image: image183.jpg]


 Select the child in the list you wish to move and press the “up/down” arrows to set the new order.   If the arrows are hidden, your desktop genealogy program strictly sorts by birth date and the order cannot be changed using this method. 
Non-Touchscreen
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With some imports, you can change the order of the children.   

Use the “Edit”, “Children” menu item to invoke the “Children List XE "Children List" ”.

Select the child in the list you wish to move then use the “Move up” or “Move down” menu item. 

Setting a Spouse as Preferred
Touchscreen XE "Spouse:Preferred" 
[image: image458.png]Relationships <« I
As Chi

Father-gio  Aender, John
Mother-Bio__ Woods, Delah
—

As Parent:

Dau-Bio __Aeiander, Luls Elzsbeth




Some desktop genealogy programs allow you to set the “preferred” spouse.  When an individual becomes the “current couple”, Pocket Genealogist will attempt to display the “preferred” spouse if multiples exist.    
[image: image184.png]


 or [image: image185.png]


 to invoke the “Spouse List XE "Spouse List" ” or use the “Edit” menu.

[image: image186.jpg]


 Select the spouse in the list and press the “Set to Preferred XE "Preferred" ” button. 
Non-Touchscreen
Some desktop genealogy programs allow you to set the “preferred” spouse.  When an individual becomes the “current couple”, Pocket Genealogist will attempt to display the “preferred” spouse if multiples exist.    

[image: image187.png]


 or [image: image188.png]


 on the 3-Gen view to invoke the “Spouse List XE "Spouse List" ” or use the “Edit” menu.

Select the spouse in the list then use the “Set to Preferred XE "Preferred" ” menu item.
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Setting a Child as Preferred
Touchscreen XE "Child:Preferred" 
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Some desktop genealogy programs allow you to set the “preferred” child.   
[image: image189.jpg]


 to go to the “Children List XE "Children List" ” or use the “Edit” menu.
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 Select the child in the list and press the “Set to Preferred XE "Preferred" ” button.

Non-Touchscreen
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Some desktop genealogy programs allow you to set the “preferred” child.   

Use the “Edit”, “Children” menu item to invoke the “Children List XE "Children List" ”.

Select the child in the list then use the “Set to preferred” menu item.

. 
Setting Parents as Preferred
Touchscreen XE "Parents:Preferred" 
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Some desktop genealogy programs allow you to set the “preferred” parents.  When an individual becomes the “current couple”, Pocket Genealogist will attempt to display the “preferred” parents if multiples exist.   
[image: image191.jpg]


 to display the “Parents list” or use the “Edit” menu.

[image: image192.jpg]


 Select the parents in the list and press the “Set to Preferred XE "Preferred" ” button. 
Non-Touchscreen
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Some desktop genealogy programs allow you to set the “preferred” parents.  When an individual becomes the “current couple”, Pocket Genealogist will attempt to display the “preferred” parents if multiples exist.   
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 Use the “Parents” button on the 3-Gen view to display the “Parents list” or use the “Edit” menu.

Select the parents in the list then use the “Set to Preferred XE "Preferred" ” menu item. 
Viewing TMG XE "The Master Genealogist"  “Relationship” information

Touchscreen
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With imports from The Master Genealogist XE "The Master Genealogist" , you can view the relationship information of an individual from the perspective of a parent or as a child.   This information can be found on the “Relationships XE "Relationships" ” tab on the Individual screens.
Non-Touchscreen
With imports from The Master Genealogist XE "The Master Genealogist" , you can view the relationship information of an individual from the perspective of a parent or as a child.   This information can be found on the “Relationships XE "Relationships" ” tab on the Individual screens.   Depending on the screen orientation of your device, you may need to scroll down to see all the information.  (D-Pad up/down button)
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Setting Couple as “Not Married XE "Not Married" ”

With Legacy XE "Legacy Family Tree"  Family Tree imports, you can assign a “Not Married XE "Not Married" ” flag to a couple.  Go to the “Misc” tab for the family information to set this flag.
Setting an Individual to “Never Married XE "Never Married" ”

With Legacy XE "Legacy Family Tree"  Family Tree imports, you can indicate that an individual never married.  Go to the “Misc” tab for the Individual information to set this flag.  (This value cannot be set if the individual has a spouse)
Setting Husband Phrase XE "Husband Phrase" 
With Legacy XE "Legacy Family Tree"  Family Tree imports, you can set the phrase that is used to designate the “husband” in a relationship.    For example, you could change it to “Partner” if that couple was never married.    Go to the “Main” tab for the family information screens for that couple to set this value.
Setting Wife Phrase XE "Wife Phrase" 
With Legacy XE "Legacy Family Tree"  Family Tree imports, you can set the phrase that is used to designate the “wife” in a relationship.    For example, you could change it to “Partner” if that couple was never married.    Go to the “Main” tab for the family information screens for that couple to set this value.
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Setting the Child Status
Touchscreen XE "Child Status" 
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If your desktop genealogy program supports a child status field such as “Twin” or “Stillborn”, you can find this field on the “Children list” screen.  
 Use [image: image194.jpg]


 to invoke the “Children List XE "Children List" ” screen or use the “Edit” menu.

Select the child in list to display the status.  Tapping on the field will display a list of available values.   

Note: With Legacy Family Tree, either of the “Relationship to” values can be set as  “Private”.
Non-Touchscreen
[image: image471.png]Select an Item apabc

Father
Mother
Brother
Sister
Spouse
Son
Daughter




If your desktop genealogy program supports a child status field such as “Twin” or “Stillborn”, you can find this field on the “Children list” screen.  

Use the “Edit”, “Children” menu item to invoke the “Children List XE "Children List" ”.

Select the child in list then use the D-Pad right button to exit the list and move to the “Status” field.  Use the D-Pad “Enter” button will display a list of available values.     

Setting the Child Relationship XE "Child Relationship"  to Parents
If your desktop genealogy program supports a relationship to parents field such as “Adopted” or “Step”, you can find this field on the “Children list” screen.  You can display this screen either using the [image: image195.jpg]


 button or the “Edit” menu.  Select the child in the list to display the relationship to the parent(s).  Tapping on the field will display a list of available values for that field. If child status is also supported, you may need to press the button next to the display field to toggle between the status and the relationship fields.   

Setting User Reference XE "User Reference"  ID

If your desktop program supports a User Reference XE "User Reference"  ID field for Individuals or Families, go to the “Identifiers XE "Identifiers" ” tab when viewing the Individual or Family screens to set this value.
Setting AFN XE "AFN" 
Same as “Setting User Reference ID”.
Setting RFN XE "RFN" 
Same as “Setting User Reference ID”.
Finding the number of Individuals in a database

You can find a count of the number of individuals in your database from the “Properties” screen invoked from the “File” menu.
Finding the number of Families in a database

You can find a count of the number of families in your database from the “Properties” screen, which is invoked from the “File” menu.
Finding the number of Field Notes XE "Field Notes" 
You can find a count of the number of Field Notes XE "Field Notes"  in your database from the “Properties” screen which is invoked from the “File” menu.
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Set the Sex of an Individual

The sex XE "Sex"  of the individual can be set on the “Main” tab of the Individual screens.  The drop down list will contain the values acceptable to your desktop genealogy program.   If only one value is in the list, this indicates you can’t change the value for this individual. (With some programs once you have a spouse attached you can’t change the sex)   As with all fields in Pocket Genealogist, what you can set will depend on the capabilities of your desktop program.
Set an Individual as “Private XE "Private" ”

If your desktop genealogy program supports setting an individual to “private”, this flag will be available on the “Main” tab of the Individual screens.
Set Living indicator

Different desktop genealogy programs handle a “Living” indicator differently, and some programs don’t have this type of flag.   Pocket Genealogist sets these flags differently based on the capabilities of your desktop program.   You may be able to change this flag directly or it may be automatically set based on the existence of a Death XE "Events:Death" 

 XE "Death Event"  or Burial XE "Events:Burial" 

 XE "Burial Event"  event (or both).   The living XE "Living"  flag can be found on the “Main” tab for an Individual.   

Set Anc/Des Interest XE "Descendant Interest" 

 XE "Ancestor Interest" 
If your desktop genealogy program supports an ancestor and descendant interest field, you can find it on the “Main” tab for the Individual.

[image: image475.png]Type

“Desth
“Burisl
At Birh

Disproven
Census

Census
Mitary

Date

& Mar 1265
Mar 1265
Aot 1794

180
1810

15 5ep 18139

3 Delete





[image: image476.png]Select item from lst

Chrstening

accdent
adoption
At Birh
At Burl

At Desth
Baptim

 — |







[image: image477.png]BROWN, Asa CLARK






Sort the Event List

Touchscreen
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You can sort XE "Sort"  the event list by tapping on the column headers. Tapping a second time on the same column header will reverse the sort.   If your desktop genealogy program allows the sorting of event, a “Save” button will be displayed.  A “Sort” button will also be shown if you wish to reset the list. If you press the “Save” button to keep the new order, both buttons will disappear until the order changes again.  The “up/down” arrows are another method for changing the order.
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	Save the sort XE "Sort"  order created by tapping on the column headers.

	[image: image197.jpg]



	Sort the list back to original order before the “column header sort” XE "Sort" .
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	Order the selected item in the list up or down one item per click.


Non-Touchscreen
Currently the ability to sort the lists by tapping on the list column headers is not supported.   However, if your desktop genealogy program supports it, you can change the order of the events by selecting the event in the list and using the “Move up” and “Move down” menu item.
Setting an Event as Preferred XE "Events:Preferred" 
Touchscreen
Some desktop genealogy programs allow you to indicate the “preferred” event when multiple events of the same type are in the list.  The “preferred” event is designated in the list by an asterisk.   To set an event as preferred, select the event in the list and press the “Preferred XE "Preferred" ” [image: image199.jpg]


 Button.

Non-Touchscreen
Some desktop genealogy programs allow you to indicate the “preferred” event when multiple events of the same type are in the list.  The “preferred” event is designated in the list by an asterisk.   To set an event as preferred, select the event in the list and use the “Set to preferred” menu item.
Swapping Primary Events
Touchscreen XE "Events:Swapping Primary" 
Some desktop genealogy programs allow multiple instances of primary events such as Birth XE "Events:Birth" 

 XE "Birth Event" .  Only one Birth will be considered the primary and will be designated with an asterisk.   If you wish to swap the non-primary event with the primary, select the non-
primary event in the list and press the “Preferred XE "Preferred" ” [image: image200.jpg]


 button.  
Note: Primary events are always designated with an asterisk.
Non-Touchscreen
Some desktop genealogy programs allow multiple instances of primary events such as Birth XE "Events:Birth" 

 XE "Birth Event" .  Only one Birth will be considered the primary and will be designated with an asterisk.   If you wish to swap the non-primary event with the primary, select the non-primary event in the list then press the “Set to preferred” menu item.
Note: Primary events are always designated with an asterisk.
Changing the order of Events XE "Events:Order" 
With some imports, you can change the order of the events.   See “Sort the Event list” for various ways this can be done. 

Setting Cause of Death XE "Cause of Death" 
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Cause of Death XE "Cause of Death" , if supported by your desktop genealogy program, is attached to the primary Death XE "Events:Death" 

 XE "Death Event"  event for the Individual.   Even if you don’t have any other information regarding the death, such as date or location, you still need to create a Death event in order to enter “Cause”.
Add a source citation XE "Citation (Source)"  to Cause of Death XE "Cause of Death" 
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Some desktop genealogy programs allow you to attach a source citation XE "Citation (Source)"  to the Cause of Death XE "Cause of Death"  field.   This is a separate citation from the event itself.  These “special” citations don’t show up on the source citation display for the event.  They can be found on the view/edit screen for the item that is cited.   This example shows the source citation buttons on the view/edit screen for cause of death which can be used to view/edit the citations for that field.
Non-Touchscreen
Use the menu to add or list the source citations attached to cause of death.
Citation “Applies To XE "Citation (Source):Applies To" 

 XE "Applies To" ”

Most desktop genealogy programs only allow you to add a source citation XE "Citation (Source)"  to an entire event.   However, some desktop genealogy programs, such as Family Historian XE "Family Historian"  or Genbox XE "Genbox" , allow more control over what the citation is applied toward.   (such as only the date or the place in the event.)    Use the “Apply To” drop down list on the citation screen to make this selection.
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Additionally, this “Apply To” field may be available for other imports.   For example,  you can use this to create a source citation XE "Citation (Source)"  for the “Never Married XE "Never Married" ” flag for Legacy XE "Legacy Family Tree"  Version 6 when adding a citation to the Individual. 

Legacy XE "Legacy Family Tree"  specific Source Citation XE "Source Citation" s
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The Relationship to parents, child status and Cause of Death XE "Cause of Death"  source citations do not show up on the “Source” screen.  These sources can be found from the view/edit screen for each field.  This example is for Child Status XE "Child Status" .   First an “Edit”, “Children” was selected from the menu from the “3-gen” screen.  

In order to see the citations or to change the Status field for the selected child, “tap” on the field to bring up the Child Status XE "Child Status"  list.
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You can select the status you wish from the list or add a new one using the “Add” button.  Even if you select <None> (which sets the status to an empty value), you can still assign a source citation XE "Citation (Source)"  using the sourcing buttons at the bottom right of the screen.

Non-Touchscreen
Use the menu to set source citations.
Go To XE "Go To"  Individual

If you know the RIN XE "RIN"  (Record ID Number) or the Pocket Genealogist ID of an Individual, you can “Go To XE "Go To" ” that person using the menu item under “Tools”.
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	After entering a number in the edit field, press this button to retrieve the information for that ID.
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	Used to go to the next ID # in the database.
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	Used to go to the previous ID # in the database.
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	Shows the immediate relations for the selected person.
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	Used to display the view/edit screens for the ID selected.


Go To XE "Go To"  Family

Works the same as “Go To XE "Go To"  Individual” but for Family ID’s.

Note: You can switch between “ID” and “RIN” using the top “List” field.
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Note: Whoever is displayed on the screen when you press “OK” or “Done” will be set to the current person in  the view.  (Such as the 3-gen view.)

Set “Home” Family

You can set the “Current Couple XE "Current Couple" ” to the preferred “Home” family from the “Tools”, “Home Family XE "“Home” Family" ”, “Set Preferred XE "Preferred" ”.
Go To XE "Go To"  “Home” Family

You can make the preferred “Home” Family the “Current Couple XE "Current Couple" ” in the view by using the “Tools”, “Home Family XE "“Home” Family" ”, “Goto Preferred XE "Preferred" ”.
Find XE "Find"  “Last Edited” date for an Individual or Family

If you have your database locked as “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ” and your desktop genealogy program supports “Last Changed Date”, then that information will be available in Pocket Genealogist.   The information will be found on the “Main” tab for Individuals and Families.
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Find XE "Find"  by Name
Touchscreen XE "Name:Finding" 

 XE "Find:By Name" 
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You can search for individuals in your database by references to given or surname.   You can do the search from the “Tools”, “Find XE "Find" ”, “by Name List” menu item.   The “Find” display allows you to pick the first letter of the name and will display a list and how many references there are for that name.  The example to the right shows the result of using the “All” selection.   Select an item in the list and details of the names using that value are displayed.  
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Shown are all the “Brown” individuals in the database.  Select an item in that list and press “OK” to make that person the selected individual in the view you are using.   Alternately, you can use the buttons at the bottom to display more information about that individual.
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	Used to display alternate keys in the keypad XE "Keypad"  area such as numerals and diacritics.
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	This displays alternate character sets you can use for the “Alt” display.  (Greek for example)
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	Allows you to return to the summary screen instead of starting over with the search.

	[image: image209.jpg]



	Shows the immediate relations for the person selected in the list.
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	Displays the Individual screens for the person selected in the list.


Non-Touchscreen
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You can search for individuals in your database by references to given or surname.   You can do the search from the “Tools”, “Find XE "Find" ”, “by Name List” menu item.  The “Find” display allows you to pick the first letter of the name and will display a list and how many references there are for that name.  The example to the right shows the result of selecting “All” for surnames.   Select an item in the list and press the D-Pad “Enter” to display the details for that item. 

[image: image491.png]| Propartias

THG V6 (Direct)

Locked (view only)





All items with that surname in the database will be displayed along with additional details.  Select an item in that list and press the D-Pad “Enter” button to make that person the selected individual in the view you are using.
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	Edit
	Displays the Individual “tabs” for the person selected in the list.

	Relationships
	Shows the immediate relations for the person selected in the list.

	Character Set
	Displays alternate character sets.  (Greek for example)

	Back
	Return to the summary (1st) screen.


Tip: Both fields at the top of the screen contain a “list” of values that can be selected.  Use the D-Pad left or right buttons to change the field or press the D-Pad “Enter” button to display a list of available values.
Find XE "Find"  by Location
Touchscreen XE "Location:Finding" 

 XE "Find:By Location" 
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You can search for individuals in your database by references to locations that they use in Events.  You can do the search from the “Tools”, “Find XE "Find" ”, “by Location List” menu item.   The “Find” display allows you to pick the first letter of the location and will display a list and how many references there are for that location.   The example to the right shows the result of using the “All” selection.  Select an item in the list and more details will be displayed.

[image: image494.png]wisc Co[ 4]P]

Database to Open st St
[Dspiay st of Databases

Jiays Open ts Database.
oen Last Used Database





Select an item in that list and press “OK” to make that person the selected individual in the view you are using.
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	Used to display alternate keys in the keypad XE "Keypad"  area such as numerals and diacritics.
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	This displays alternate character sets you can use for the “Alt” display.  (Greek for example)
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	Allows you to return to the summary screen instead of starting over with the search.
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	Shows the immediate relations for the person selected in the list.
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	Displays the Individual screens for the person selected in the list.


Non-Touchscreen
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You can search for individuals in your database by references to location that they use in events.  You can do the search from the “Tools”, “Find XE "Find" ”, “by Location List” menu item.  The “Find” display allows you to pick the first letter of the location and will display a list and how many references there are for that location.  The example to the right shows the result of selecting “All”.   Select an item in the list and press the D-Pad “Enter” to display the details for that item. 
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All items with that location in the database will be displayed along with additional details.  Select an item in that list and press the D-Pad “Enter” button to make that person the selected individual in the view you are using.
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	Edit
	Displays the Individual “tabs” for the person selected in the list.

	Relationships
	Shows the immediate relations for the person selected in the list.

	Character Set
	Displays alternate character sets.  (Greek for example)

	Back
	Return to the summary (1st) screen.


Tip: Both fields at the top of the screen contain a “list” of values that can be selected.  Use the D-Pad left or right buttons to change the field or press the D-Pad “Enter” button to display a list of available values.

Find XE "Find"  by To Do XE "To Do:Finding" 

 XE "Find:To Do"  Task

Touchscreen
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You can search for To Do XE "To Do" ’s in your database by the value assigned to the task.  You can do the search from the “Tools”, “Find XE "Find" ”, “To Do”, “by Task” menu item.   The “Find” display allows you to pick the first letter of the task which will display a list of matches. The example to the right shows the result of using the “All” selection.  Select an item in the list and the task information will be displayed.
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Use the “Reference” tab to see how the To Do XE "To Do"  is used.
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	Used to display alternate keys in the keypad XE "Keypad"  area such as numerals and diacritics.
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	This displays alternate character sets you can use for the “Alt” display.  (Greek for example)
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	Found on the reference tab and used to display more information about the selected item in the list.
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	Found on the reference tab and used to set the selected individual in the list as the “current” person in the view you are using.  (also will close the Find XE "Find"  by screen.)   Note: You don’t have to be using the 3-gen view to use this button, nor will it switch you to the 3-gen screen if you are using a different view.


Non-Touchscreen
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You can search for To Do XE "To Do" ’s in your database by the value assigned to the task.  You can do the search from the “Tools”, “Find XE "Find" ”, “To Do”, “by Task” menu item.   The “Find” display allows you to pick the first letter of the task which will display a list of matches. The example to the right shows the result of selecting “All”.  Select an item in the list and press the D-Pad “Enter” to display the task information.

Tip: XE "Tips"  Pressing “All” provides an easy way to see all To Do XE "To Do" ’s in your database. 

Tip: Both fields at the top of the screen contain a “list” of values that can be selected.  Use the D-Pad left or right buttons to change the field or press the D-Pad “Enter” button to display a list of available values.
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The “Switch” field at the top is used to show the other “tabs” for the To Do.   The “Reference” tab is used to see what references this To Do.
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You can View/Edit the individual from the reference tab using the “Edit” menu item.   The “Go to” menu item will make this individual the current selected person in the view you are using.

	
	


Find XE "Find"  by To Do XE "To Do:Finding" 

 XE "Find:To Do"  Repository
Touchscreen XE "Repository" 
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If your desktop genealogy program supports attaching a Repository XE "Repository"  to a To Do XE "To Do" , you can search for To Do’s associated with that Repository from the “Tools”, “Find XE "Find" ”, “To Do”, “by Repository” menu item.  The “Find” display allows you to pick the first letter of the Repository name, which will display a list of matches. The example to the right shows the result of using the “All” selection.  Select an item in the list and the To Do’s, if any, will be displayed.
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Selecting an item in the list allows you to then press the “Open” button to display information about that To Do XE "To Do" .
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	Used to display alternate keys in the keypad XE "Keypad"  area such as numerals and diacritics.
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	This displays alternate character sets you can use for the “Alt” display.  (Greek for example)
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	Allows you to return to the summary screen instead of starting over with the search.
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	Displays the Individual screens for the person selected in the list.


Note:  For desktop genealogy programs that allow you to attach a To Do XE "To Do"  to a Repository XE "Repository"  (instead of a Repository to a To Do), use the Master List for Repositories to find those To Do’s.
Non-Touchscreen
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If your desktop genealogy program supports attaching a Repository XE "Repository"  to a To Do XE "To Do" , you can search for To Do’s associated with that Repository from the “Tools”, “Find XE "Find" ”, “To Do”, “by Repository” menu item.  The “Find” display allows you to pick the first letter of the Repository name, which will display a list of matches. The example to the right shows the result of selecting “All”.  Select an item in the list and press the D-Pad “Enter” to display To Do’s (if any) attached to that repository.

[image: image506.png]<5655 Bk

Comment
Legacy Sample

[Backus priorto making changes =t Lycoming
|County courthouse|





Select an item in the list then use the “Edit” menu item to display the task information XE "To Do" .
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	Edit
	Displays the task information for the selected To Do.

	Character Set
	Displays alternate character sets.  (Greek for example)

	Back
	Return to the summary (1st) screen.


Note:  For desktop genealogy programs that allow you to attach a To Do XE "To Do"  to a Repository XE "Repository"  (instead of a Repository to a To Do), use the Master List for Repositories to find those To Do’s.
Find Multimedia

Touchscreen XE "Find Multimedia:Touchscreen"  XE "Multimedia:Find (Touchscreen)" 
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If your desktop genealogy program supports Multimedia you can transfer the information to the device.  (Only images and pdf files are synchronized, but the information about the other types of multimedia will still be shown in the list)   From the menu select “Tools”, “Find”, “Multimedia”.  The “Find” display allows you to pick the first letter of the Caption or Description associated with the multimedia object and will display a list of matches. The example to the right shows the result of using the “All” selection.  Select an item in the list and the multimedia object will be displayed.
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Select the “Info” tab to see information about the multimedia object such as Caption, Date, Description, etc.   (Information depends on what is available in your desktop genealogy program)

Note:  If the image is smaller than what can be displayed on the screen, you can select the “Stretch” option to display it larger.   “Stretch” is a “sticky” option.  Once you select or deselect it, that value will be used as the default for the display of subsequent images.
Non-Touchscreen XE "Find Multimedia:Non-Touchscreen" 

 XE "Multimedia:Find (Non-Touchscreen)" 
[image: image511.png]Conyright (€) 1995-2007
Northarn Hils Software LLC

Support@NorthernilsSoftuare com
NertharnkilsSoftwzre.com




If your desktop genealogy program supports Multimedia you can transfer the information to the device.  (Only images and pdf files are synchronized, but the information about the other types of multimedia will still be shown in the list)   From the menu select “Tools”, “Find”, “Multimedia”.  The “Find” display allows you to pick the first letter of the Caption or Description associated with the multimedia object and will display a list of matches. The example to the right shows the result of using the “All” selection.  Select an item in the list and the multimedia object will be displayed.
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Select “Info” from the “Switch List” to see information about the multimedia object such as Caption, Date, Description, etc.   (Information depends on what is available in your desktop genealogy program)

Note:  If the image is smaller than what can be displayed on the screen, you can select the “Stretch” option from “Menu” to display it larger.   “Stretch” is a “sticky” option.  Once you select or deselect it, that value will be used as the default for the display of subsequent images.
Displaying all To Do XE "To Do" ’s

You can display all the To Do XE "To Do" ’s in the database either from the Master List or by doing a “Tools”, “Find XE "Find" ”, “by To Do Task” and selecting “All” from the Find screen.
Setting the display Language

You can change the display language for Pocket Genealogist from the “Language” screen found from “File”, “Language”.   Select the language in the list and press “OK”.   If you use “System Default”, the current regional settings will be used for the display if a match can be found.

Note: The calendar and date calculator use the value in “Regional Settings XE "Regional Settings:Use of" ” to determine the text strings (such as month names) and cannot use the selection from the Pocket Genealogist language version.  Dates entered directly still work properly.
The Master Genealogist XE "The Master Genealogist:Flags"  Flags
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The flags in The Master Genealogist XE "The Master Genealogist:Flags" 

 XE "Flags:The Master Genealogist"  can be found under the “Facts” screen for the Individual.   Since TMG does not support the flag data in GEDCOM XE "GEDCOM"  files, you cannot edit this information on the device. 
Note: Other desktop genealogy programs support similar features.  If those programs support GEDCOM XE "GEDCOM"  processing of that data, you will be able to add/edit the information on the “Facts” screen.   If it’s a Y/N flag, adding the flag to the list assumes “Y”, and deleting the flag from the list assumes “N”.
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Turning off “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ”
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If you have synchronized your database as “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ” and decide later you wish to enter data, you can turn off “View Only” on the device.   Go to “File”, “Properties”.

Note: You cannot turn “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ” back on once you turn it off without re-importing your database.
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Turning off 2-way synchronizing

You can turn off the 2-way synchronization feature of Legacy XE "Legacy Family Tree"  Family Tree databases on the device.  Go to “File”, “Properties” and uncheck the “2-way Synchronizations’ button.

Note: You cannot turn this back on once you turn it off without re-importing your database.

Change to a different View XE "View:Changing" 
You can change the “View” from the “Edit”, “View” menu or you can use the icons on the views that have them.
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Configure use of a GPS XE "GPS" 
Pocket Genealogist supports GPS XE "GPS"  coordinate retrieval from GPS devices that support the intermediary driver with Windows Mobile 5 or 6 (which allows you to share the GPS with other programs simultaneously).   You may also use a GPS device with any version of Windows Mobile by directly communicating using the “COM” port but cannot share the device with another program XE "Windows Mobile 5 or 6" .   
It is assumed that you currently have the GPS device working with the GPS software that came with your device.   
GPS intermediary driver

1. Go to your GPS XE "GPS"  software and look up the COM port that is being used to communicate with the device.

2. From the Windows “Start” menu, select “Settings”

3. Select the “System” tab.

4. Select the GPS XE "GPS"  icon.

5. On the “Hardware” tab, set the “GPS XE "GPS"  hardware port” to the COM port you verified above.  The Baud rate is generally 4800 or less.  (Your GPS device should have documentation that will tell you the maximum speed that is supported, but 4800 is a good starting point.)

6. On the “Programs” tab, set “GPS XE "GPS"  program port” to any port other than COM 0 or the port you just entered under the hardware tab.

7. On the “Access” tab, check the “Manage GPS XE "GPS"  automatically”.

8. Change your GPS XE "GPS"  software to use the new port specified on the “Programs” tab.

9. Verify that your GPS XE "GPS"  software still works.

10. Go to the “GPS” tab found from “Edit”, “Configuration” in Pocket Genealogist on the device.   Select “Shared” as the Port.

11. Test Pocket Genealogist to see if the GPS XE "GPS"  support works.  Go to “Tools”, “Calculators”, “Coordinates” and press the globe icon or use the menu item to retrieve the coordinates from the GPS device.
The intermediary driver will allow both your GPS XE "GPS"  software and Pocket Genealogist access to the GPS device concurrently.

Using Serial Communications (COM)

If your device does not support the intermediary driver or you have problems using it, you can also directly communicate with the GPS device using the appropriate COM port.

1. Go to your GPS XE "GPS"  software and look up the COM port that is being used to communicate with the device.

2. Go to the “GPS” tab found from “Edit”, “Configuration” in Pocket Genealogist on the device.   Select the port found under step 1.

3. In most cases a Baud rate of 4800 is appropriate.

4. Test Pocket Genealogist to see if the GPS XE "GPS"  support works.  Go to “Tools”, “Calculators”, “Coordinates” and press the globe icon or use the menu item to retrieve the coordinates from the GPS device
If you are using Windows Mobile 5 or 6 , you may still need to set the values found under the “GPS” icon (“Start”, “Settings”, “System” tab). 

Retrieve GPS XE "GPS"  Coordinates

If you have a GPS XE "GPS"  device you can retrieve the current GPS coordinates for use with locations, repositories, addresses and notes.  (Use depends on the capabilities of your desktop genealogy program.)  On the screen where you enter GPS coordinates, press the “Globe” icon to retrieve the current location.    On the notes edit screen, use the “Globe” icon to retrieve the current GPS coordinates.
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If a connection is successfully established to the GPS device, information about the current coordinates will be displayed.   This information is refreshed every few seconds.  

The “Satellites” value will indicate the number of satellites seen by the device.   UTC Time is “Coordinated Universal Time” which is the base point for time zones around the globe.  
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Switch to Landscape Orientation XE "Landscape:Device switching" 

 XE "Device:Orientation switching" 
For devices that support both Portrait and Landscape orientation, you can switch from the control panel in Windows Mobile, or from within Pocket Genealogist.

In Windows Mobile you can find it with the “Screen” icon under “Start”, “Settings”, “System” tab.

In Pocket Genealogist use “Tools”, “Device”, “Orientation”.
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An example of the 3-gen screen with Landscape orientation.
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Displaying Multimedia XE "Multimedia:Displaying" 

 XE "Photos:Displaying" 

 XE "Images:Displaying" 
If your desktop program supports multimedia you can synchronize images to the device.   (Only Images and pdf files are supported, video and other multimedia objects are not)  Depending on the capabilities of your desktop program, you can have multimedia objects attached to Individuals, Families, Events, LDS Ordinances, Sources, Citations, Repositories, Addresses, Locations, LDS Temples and “General”.  
You will find a “Multimedia” button on the screens associated with each type above (Events for example) or as a separate “tab” for items such as Sources or Citations.   
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For Individuals, Families, Events or LDS Ordinances, you can use the “Multimedia” tab associated with the Individual or Family set of tabs for displaying those objects.

Non-Touchscreen devices work in a similar manner although there will be no “multimedia” buttons.  You will find a “Multimedia” item on the menu which can be used to invoke the display of the objects. 
Configuring the Device XE "Device:Configuring" 
Note: All configuration options are found from the “Edit”, “Configuration XE "Configuration" ” menu.
Database to open at Program Start XE "Database:Open (Device)" 
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By default, the list of databases on the device will be displayed at program start.  You can configure the program to either open a specific database or to open the last database you were working with.  This option is found on the “Database” tab under “Edit”, “Configuration XE "Configuration" ”.
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Home Family XE "“Home” Family"  at Program Start

By default, the “Preferred XE "Preferred" ” home family is displayed when you open a database.  See “Set Home Family XE "“Home” Family" ” for more information on how to change the home family.   You can also set Pocket Genealogist to open the last family viewed before last closing the database.  This option is found on the “Database” tab under “Edit”, “Configuration XE "Configuration" ”.
Set Default View XE "View:Default" 
The 3-generation view is the default view for Pocket Genealogist.   You can change the view that is shown by default at program start from the “View” tab found under “Edit”, “Configuration XE "Configuration" ”.

3 Generation

[image: image526.png]74 | Keebler, Benjamin ) Y 1
(Tosk Reference]
e[ Dsc 1592
Task [Phonchil - gt Temesses Kesbl
[ Designed [90ec19%2 |

Expenses 0,00
Keywords [KEEBLER

Comment Trace ancesry of Berjamin
[Frankin Keeblr. =




The “Collapse Child Window” option will display the icon bar at the bottom of the screen or you can use the collapse icon on the menu bar to raise and lower it.
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Tree Views

You can set the number of generations to include when you select a tree view XE "Descendant Tree View:Generations to display" 

 XE "View:Tree generations to display" 

 XE "Ancestor Tree View:Generations to display" .  Pocket Genealogist supports up to 255 generations with the tree views.
Set 3-Gen Colors XE "View:3-Generation Colors" 

 XE "Color:3-Generation View" 
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By default the 3-gen screen has no colors set.   You can change the background and text colors for the selection boxes on the “3-Gen Color” tab found under “Edit”, “Configuration XE "Configuration" ”. 

Tap on the “Box” you wish to change and you will be presented with a color selection screen.

The color selection screen shows the 16 standard colors available with all Windows handheld devices.  With some devices, you can also tap on either of the two “Custom” color boxes to display up to 64 different colors to choose from.   (You get the same colors when you tap on either of the “custom color” boxes, the first one shows the selection for “Text” and the second for “Background”)
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Set Miscellaneous Colors XE "Color:Miscellaneous on Device" 
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The Misc. Color options allow you to set the color of data fields and data fields that have changed on the device.   You can also set the background and text color for push buttons, List columns and text within the list.  
Tap on the item to set the color.   

The color selection screen shows the 16 standard colors available with all Windows handheld devices.  With some devices, you can also tap on either of the two “Custom” color boxes to display up to 64 different colors to choose from.   (You get the same colors when you tap on either of the “custom color” boxes, the first one shows the selection for “Text” and the second for “Background”.)
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Misc

Uppercase Surnames XE "Uppercase Surnames" 

 XE "Surname:Uppercase" 
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This option will cause all surnames to be displayed in uppercase.

Display Given Name First XE "Given Name:Display first" 
This controls how names are displayed in lists, trees and the 3-gen screen.

Smart Minimize XE "Smart Minimize" 
This controls the function of the “X” button found on the main Pocket Genealogist screens.  (3-gen for example.)   When selected, the “X” button will not close the program but will minimize it.
Save Column width and position

You can resize and change the order of the column headings for the lists in Pocket Genealogist.   To resize the columns, tap and hold the separator between the column headings and slide it.   To move a column, tap and hold on any column heading and move it to the desired location.  This option will automatically save changes as you make them.

Note: “Smart Minimize” and “Save column width and position” is not available on Non-Touchscreen devices.
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GPS XE "GPS" 
This changes the default display format for latitude and longitude in Pocket Genealogist.  Also, if you have a built-in GPS or one connected via bluetooth or other method, you can configure Pocket Genealogist to use the GPS for retrieving coordinates.   Use the globe icon to test your GPS after you set the port and baud rate.
Prompts
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These options control some of the prompts that can occur in Pocket Genealogist.  Selecting these items turns them off.
Disable Surname Prompts XE "Surname:Prompt (disabling)" 
Turning this on will disable the prompt that occurs when you add a new surname to the database.
Disable Given name Prompts XE "Given Name:Prompt (disabling)" 
Turning this on will disable the prompt that occurs when you add a new given name to the database.
Disable Location Prompts XE "Location:Prompt (disabling)" 
Turning this on will disable the prompt that occurs when you add a new location to the database.
Disable Find Prompts XE "Find:Prompt (disabling)" 
During especially longs searches in the database, you will be prompted every 50,000 records to allow termination of the search.   Turning this on will disable the search prompt.
Edit
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Capitalize first letter of first word XE "Notes:Auto-Capitalization" 

 XE "Auto-Capitalization" 
When entering text into a field, this controls whether the first letter of the first word is automatically capitalized.

Hide Format Codes XE "Notes:Format Code (hiding)" 
For some imports, this will hide the format codes in the note fields.   If selected the note field will also be marked “read only” and format codes will be hidden.

Field Selection XE "Notes:Field Selection" 
Determines the location of the “cursor” and  how the text is selected when a note field is displayed for editing.

Change Font size XE "Font size" 

 XE "Device:Font size" 
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You can change the font size of the 3-gen view, the tree views, the lists and the edit fields within Pocket Genealogist.   (Each can have a different size if desired.)   With Windows Mobile 2003 Second Edition and newer devices, you can change font sizes globally on the device.   With Pocket Genealogist, you can use the size as defined in the system or set your own. 

With Windows Mobile, go to “Start”, “Settings”, “System” tab, “Screen” icon, “Text Size” tab.   Adjust the slider to increase or decrease the size of the fonts on a global basis.

Pocket Genealogist can be set to use custom sizes within Pocket Genealogist or to use the System setting.   Use the “Font” tab from “Edit”, “Configuration XE "Configuration" ” to set the value you wish to use.   The drop down list allows you to set it for each of the items that support a custom size.   The example shows the 3-gen screen and lists with the smallest size available on a VGA XE "VGA"  device.  (The quality of the text on the actual device is very good, much better than what is shown in the screen print.) 
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Tab order XE "Tab Order"  (Individual or Family)
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You can change the order of the “tabs” for the Individual and Family screens.  Use the “Tab Order” screen from “Edit”, “Configuration XE "Configuration" ”.  

Each list shows the order that the tabs will be displayed for the Individual and Family screens.

Select the item in the list to move and press the up or down arrow to change its order.
Note: Tab order is not available for Non-Touchscreen devices.
Keys
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The Keys option allows you to set which type of keyboard XE "Keyboard"  you are using with your device.  The default is “Generic (built-in or External)” which should work with the majority of keyboards.  You can get to the “Keys” screen from “Edit”, “Configuration XE "Configuration" ”.

Note: Keys is not available for Non-Touchscreen devices.
Databases List XE "Database:List (Device)" 
[image: image543.png]7 |Brown, Asaclark @ 2V, ¢

ein ¢ [Names|Evens Note S

Given

Sumame

[fsa Clarc




The databases list can be displayed from “File”, “Databases”.  You can open, close, delete and do backups of the databases.   The database that is currently open on the device will have an “*” next to it.  For each database you will be shown the name, the amount of space it uses and where it is stored.   
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	Used to open a database. If another database is already open, it will be closed automatically.
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	Used to delete a database.   Deleting a database XE "Database:Deleting (Device)"  on the device does not delete the same database on the desktop, they must be done separately.
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	Used to Refresh XE "Refresh"  the list of databases.  Useful when you change storage cards XE "Storage Card"  with this screen displayed.
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	Closes the current open database, if any.  You do not need to select the open database in the list first, just press this button to close the current open database.
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	Used to create a new backup of the database selected in the list.  
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	Used to restore using one of the backup sets you’ve already created.   Restoring a database will overwrite the original if it still exists on the device.


Deleting a database XE "Database:Deleting (Device)" 
You can delete a database from the “File”, “Databases” menu.   Select the database in the list to delete and press the “Delete” button or use the “Delete” menu item.   You do not need to close the database first, and you will always be prompted to confirm your choice of deletion.
Opening a database XE "Database:Open (Device)" 
To open a database in Pocket Genealogist, go to the list of databases from the “File”, “Databases” menu.   Select the database in the list and press the D-Pad “Enter” button, or press the “Open” button or use the “Open” menu item.  You do not need to close the current open database first.
Backup XE "Backup" /Restore of your database XE "Database:Restore (Device)" 

 XE "Database:Backup (Device)" 
Backup XE "Backup" 
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 Select the database in the database list and press the “Backup XE "Backup" ” button to create a new backup.    Any open databases will first be closed.  The Backup screen allows you to pick the location where you would like to put the backup using the “To” drop down list.   The amount of free space at that location will be displayed and if there is not enough for the backup you won’t be able to use that location.  If you remove a storage card and put in another, press the “Refresh XE "Refresh" ” button to make sure the space information is updated.
You can also delete backups from this list, select the backup in the list (this example doesn’t show any) and press the “Delete” button.
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	Create a new backup
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	Delete a backup
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	Refresh XE "Refresh"  display


Press the “Add” button to create a new backup at the “To” location.  You can enter a comment for the backup if you wish.
Note: If your database contains images, you will be prompted if you wish to include multimedia as part of the backup.  If you say “No”, when you restore that database all multimedia objects will be “lost” until you re-import the database.

Restore XE "Restore" 
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 Press the “Restore XE "Restore" ” button to display a list of backups.   The “From” drop down list allows you to select the location of the backups.  Select the backup you wish to restore from the list and you will then be able to pick the “To” location where you wish to put the restored database.  Any databases by that same name will automatically be deleted as part of the restore. 

If you change a storage card while you are on this screen, you must press the “Refresh XE "Refresh" ” button to retrieve information stored on that card.
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	Restore XE "Restore"  the database using the selected backup.
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	Delete a backup
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	Refresh XE "Refresh"  display


Note: Scroll to the right to see the comment associated with the backup.

Warning: Restoring a backup will totally replace the database with the same name on the device.

Closing Pocket Genealogist XE "Exiting Pocket Genealogist (Device)" 
To close Pocket Genealogist on the device, do a “File”, “Exit”.  (Or use the “X” button at the top right if available and not configured as “Smart Minimize”)   You should always close Pocket Genealogist before a database synchronization.
View/Edit Master Lists XE "Master Lists" 
You can view the “Master lists” in your database from “Edit”, “Master lists”.  This includes Name Prefix, Suffix, Given XE "Given Name"  names, Surnames, Locations, Sources XE "Sources" , Address XE "Address" /Repositories, Source Types, To Do XE "To Do"  Categories, Parent Relationships XE "Relationships" , Marriage XE "Marriage Event" 

 XE "Events:Marriage"  Statuses and Child Status XE "Child Status" es.    When you change an item in these lists, it changes ALL references to that item.  This is a handy way to change the spelling or capitalization of an item.   You can also add new items to some of the lists but you can’t delete.
Note: You can view all TMG XE "The Master Genealogist"  Research Log XE "To Do:Research Log" 

 XE "Research Log (See also To Do)"  entries (To Do XE "To Do" ’s) for a Repository XE "Repository"  by viewing a repository from the Master List.

Relationship list
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You will find the relationship button (or menu item) at various locations within the program.  It is used to display a list of people who are directly related to the person in question.   The current example was invoked from the 3-gen screen using the button found on the menu bar.  (Touchscreen) Shown, from top to bottom, are the current person and all aliases, followed by the parents. Next follows the spouse, the spouse’s parents and the children of the couple.  If there are additional spouses, they will follow using the same order (spouse, parents of spouse and the children of the couple).  In most cases, selecting a person in the list and pressing OK makes that person and the associated spouse the “current couple” on the 3‑gen screen.  However, in the case of the relationship display invoked from the 3‑gen screen, this would not be that useful since you can easily “navigate” to that person directly from that screen.  In this situation, selecting a person from the list and pressing OK will take you to the “Find XE "Find"  by Surname XE "Surname" ” display with that person selected.  This allows quick access to the “Find” function for that surname for easy selection of other relatives of that person.

For those imports that support “preferred” spouses, parents, and children, the “relation” column will put an * next to the preferred item.   For the “Self” entries, the primary name will have an * next to it.

Status Area

Additionally, there is a status display at the bottom of the screen.  When selecting the “Self” items, you get an indication if the name is a primary name or a secondary name (Alias).  For Parents, the status area displays the child status of the “Self” person to the Parent.  For Spouses, the status area displays the marriage date. (Or date associated with the “union” between the “Self” person and the spouse.)  For Children, the status area will display the child status to the “Self” person.

The above is only available for those imports that support these relationship statuses.  If data entry is enabled, you can “tap” on that the status field and change the value.

Date Calculator
[image: image549.png]G sample Q2T

DI

o, A Gl

11 Oct 1792 - Woodstock,

[ ar 196 sl

s

oot et

o 01, Mo

v var 62

S TLIETEI o LT
[afwl o o T o] o151

aaunu-n-nnn




Touchscreen XE "Dates:Calculator" 

 XE "Calculator:Date" 
The date calculator can be used to calculate a second date using a start date and years, months and days from that date  (either in the past or the future).   Select the 1st date, then enter the years, months and days, then press the add or subtract button to calculate the second date.

The date calculate can also be used to enter a start and an end date and it will automatically calculate the number of years, months and days between the two.  The date calculator is found from the “Tools”, “Calculators” menu.

Non-Touchscreen
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The Non-Touchscreen version of the date calculator has some differences compared to the Touchscreen version.   It does support calculation of a second date from a first plus Y/M/D, or calculation of Y/M/D between two dates.
1. You have to enter the dates “manually”, there is no “calendar” display to select the date.  
2. The date is a “Short” date, the day of the week is not shown and the month is shown as a numeric value.

3. Calculation of the number of years, months and days between two dates is automatically calculate as you change either the first or second date.

4. You can enter a first date, then values in the Years, Months, Days field, then use the “Add YMD” or “Subtract YMD” menu item to set the second date.

Soundex Calculator XE "Soundex:Calculator" 

 XE "Calculator:Soundex" 
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The Soundex calculator is used to calculate the Soundex code for a name.   The calculator is found under “Tools”, “Calculators”. 

Type in the surname and press the calculate button to display the soundex value.  For certain names, you may get two values as the result.   (Due to a little known “rule” regarding  H’s and W’s.)
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Coordinates Calculator XE "Coordinates:Calculator" 

 XE "Calculator:Coordinates" 
The coordinates calculator is not really a calculator but a convertor.  It allows you to enter a latitude and longitude value and then convert it to a different format.  You can find it from the “Calculator” menu found under “Tools”.    The Coordinates button will retrieve the current GPS XE "GPS"  setting.

Using the Relationship Calculator
Found on the menu under “Tools”, “Calculators”, “Relationships” XE "Relationship Calculator" 

 XE "Calculator:Relationship" 
Touchscreen
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The relationship calculator is used to determine the relationship between two individuals.   The relationship(s) shown in the list is always in reference to how the first person relates to the second person.   As you change person 1 or person 2 the relationships shown in the list will automatically calculate.
The “Branch 1” and “Branch 2” list shows the individuals that are common between the two ancestors.   “Branch 1” relates to person 1 and “Branch 2” relates to person 2.   (The list is always shown with the oldest generation at the top of the list and the youngest at the bottom)
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	Invokes a “Find” XE "Find"  screen to select the individual by name.
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	Invokes a “Go To” XE "Go To"  screen for selecting person 1.
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	Invokes a “Go To” XE "Go To"  screen for selecting person 2.
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	Used to swap person 1 and person 2.


Non-Touchscreen
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The relationship calculator is used to determine the relationship between two individuals.   The relationship(s) shown in the list is always in reference to how the first person relates to the second person.   As you change person 1 or person 2 the relationships shown in the list will automatically calculate.

	Lookup
	Invokes a “Find” XE "Find"  screen to select Individual 1 or 2

	By ID
	Invokes a “Go To” XE "Go To"  screen for selecting Individual 1 or 2

	Swap
	Used to swap Individual 1 and 2.


History List
Touchscreen XE "History List" 
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 Pocket Genealogist keeps track of the individuals viewed during a Pocket Genealogist session.  (Information is not retained when you close the database or exit the program.)  You can use the History buttons on the menu bar or use the menu items “Back”, “List”, or “Forward” to traverse the history list.   When you select the “List” function, you will see the individuals in the order that they were selected.  The list is a “circular” list that displays a maximum of 100 individuals/family sets.  The last viewed set is highlighted when the list is first displayed.  
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	Displays the immediate relations to the person selected in the list.
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	Deletes the item in the list but does NOT delete the individual.


Non-Touchscreen
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Pocket Genealogist keeps track of the individuals viewed during a Pocket Genealogist session.  (Information is not retained when you close the database or exit the program.)   You can display the list from the “Tools”, “History”, “List” menu item.   A list of the individuals in the order that they were selected will be displayed.  The list is a “circular” list that displays a maximum of 100 individuals/family sets.  The last viewed set is highlighted when the list is first displayed.  

If you select an item in the list, you can use the menu to view relationships to that person or to delete an item from the list.  (It will not delete the individual from the database, just the item from the history list)
Soft Reset Device

Windows Mobile devices have a feature called a “Soft Reset”.   A soft reset XE "Soft Reset" 

 XE "Device:Soft Reset"  is like a reboot.   Refer to your device manufacturers documentation on how to perform a soft reset, which is usually done by pressing a recessed button with the stylus.   There are times when a soft reset will clear up problems that may be occurring on the device.  You do not need to close your Pocket Genealogist database as it will be done for you.   However, you should close any other programs before doing the reset.

You can find the soft reset XE "Soft Reset" 

 XE "Device:Soft Reset"  under “Tools”, “Device”, “Reset”.
Note: The soft reset XE "Soft Reset" 

 XE "Device:Soft Reset"  function may not work with all devices as it depends on how the device manufacturer implemented Windows Mobile.
Hard Reset Device

Windows Mobile devices have a feature called a “Hard Reset”.   A hard reset XE "Hard Reset" 

 XE "Device:Hard Reset"  is MUCH more “extreme” than a soft reset XE "Soft Reset" 

 XE "Device:Soft Reset"  since it resets the device to the factory installed state.   All programs and data that you have put on the device will be removed during a hard reset.   This would be similar to formatting a hard drive and re-installing the operating system.  Refer to your device manufacturers documentation on how to perform a hard reset.  You will be prompted twice since it’s such a drastic step.  Pocket Genealogist and all databases will be lost if you do a hard reset.  You can find the hard reset under “Tools”, “Device”, “Reset”.

Note: The hard reset XE "Hard Reset" 

 XE "Device:Hard Reset"  function may not work with all devices as it depends on how the device manufacturer implemented Windows Mobile.
Format a Storage Card XE "Storage Card:Formatting" 

 XE "Format a Storage Card" 

 XE "Device:Format a Storage Card" 
On rare occasions you may need to format your storage card.   Pocket Genealogist has this ability which can be found from “Tools”, “Device”, “Format”.     All data on the storage card will be lost if you do a format.

Working with Dates XE "Working with Dates" 

 XE "Dates:Working with" 
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When you edit a date field in Pocket Genealogist, the date view/edit screen will be displayed.  Dates are another area in Pocket Genealogist that can work quite differently depending on the capabilities of your desktop genealogy program.  You can either enter a date with or without a “qualifier” such as “before”, a stand-alone date qualifier such as “Dead”, or any value you wish if you select “freeform”.
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Date Qualifier
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Use this date qualifier list to modify the type of date you are using.  This includes things such as “Before” or standalone items such as “Dead”.   Stand-alone items make up the entire date value and no actual date is allowed.
If you select “freeform”, you can enter any value you wish.  This is generally used when you do not have a valid date to enter in the date field or have other special needs.  Not all desktop programs support a freeform date.

Depending on what you select, the other fields on the screen will be shown or hidden.

Date Entry
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You can enter the date in the date entry field as shown.  If the date qualifier is one that expects two dates, for example “Between”, use the second date entry field for the second date.   
Depending on your desktop program, you may also have a BC (Before Christ) and DD (Double Date) checkbox available.

Calendar  XE "Dates:Calendar" 
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Use the calendar button or menu item to display a calendar that can be used to select the date for the date field.  The oldest date available using the calendar is September 14, 1752.
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Calculator XE "Dates:Calculator" 
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Use the calculator button to calculate a date to be entered into this field.   You can start with a date and add or subtract years, months and days for example.  The oldest date available using the calculator is September 14, 1752.

Note:  The second date is the one that is always returned to the date field.
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Chapter
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2-Way Synchronizing XE "Synchronization:Database" 

 XE "Database:Synchronization" 
Overview

With direct Legacy XE "Legacy Family Tree"  Family Tree imports, if you enable the “2-way Synchronizing XE "Synchronization:2-way" 

 XE "2-way Synchronizing" ” option at import time, you can make changes to data on the device OR data in Legacy then synchronize those changes to the “other side”.   (Legacy changes to the device or device changes back to Legacy)   In order for this to work, you must only change one side at a time.  If you make changes on the device, you cannot change anything in Legacy until you synchronize.  If you make changes in Legacy, you can’t make changes on the device until you synchronize.   After you synchronize, either side can then be changed but only one side at a time between synchronizations.
Before the initial Import XE "Import" 

 XE "Database:Import" 
Pocket Genealogist is very “strict” with regards to doing updates into Legacy XE "Legacy Family Tree" .  To make sure that your Legacy Database is in good shape before you do the initial import, it is recommended that you do the following:

1. Backup XE "Backup"  your database

Since the following will make changes to your database, it’s always a good idea to first make a backup.  This is done from the “File” menu, then select “Backup XE "Backup"  Family File”.  Then select the name and location for your backup.  (Backing up to your hard disk is fine. The intent is to provide a way to restore your data in case problems occur during the next few steps.)

2. Check/Repair 

Over time, things can occur in your database that could interfere with the 2-way synchronization by Pocket Genealogist.   The Legacy XE "Legacy Family Tree"  “Check/Repair” function can be used to find and fix some of these issues in the database.  This is done from the “File” menu, then select “File Maintenance”, then “Check/Repair”.   Depending on the size of your database, it may take a few seconds to much longer to perform this function.  After it is complete, if any problems were found you will be given the choice to view a problem log.   

3. Master Lists XE "Master Lists"  Cleanup

This is a handy location to combine duplicates that can cause problems for the 2-way Pocket Genealogist synchronization.  This is done from the “File” menu, then select “File Maintenance”, then “Master Lists XE "Master Lists"  Cleanup”.
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In the above screen print, the items that are important for the 2-way Pocket Genealogist synchronization are shown “checked”.   You may wish to do other items for your own benefit.

After the initial Import XE "Import" 

 XE "Database:Import" 
To verify that there are no problems in your Pocket Genealogist database that will prevent you from doing an update back into Legacy XE "Legacy Family Tree" , it is recommended that you make a small change to your database on the device after the initial import to test the process.  For example, you could change the “Ancestor Interest” value for one of the individuals in your database.  (This is found on the “Main” tab for the individual.) After making the change and closing Pocket Genealogist on the device, go to Pocket Genealogist on the desktop and do a synchronize for the database.   It should determine that a change was made and prompt you to do the update into Legacy.  (More details in the following sections.)  If the update is unsuccessful, please send a copy of your database (FDB file) to Northern Hills Software so we can evaluate the situation.
Updating Legacy XE "Legacy Family Tree"  with changes from the device
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After you’ve made changes on the device, close the program and go to Pocket Genealogist on the desktop.  Use the “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” button to retrieve the changes.   On the synchronization screen, before you press start, you’ll notice that the “Action” listed at the bottom right indicates that changes on the device will be retrieved and placed in the Pocket Genealogist database on the desktop.  (“Here”)   No changes will be made to the Legacy XE "Legacy Family Tree"  database yet.   After synchronization is complete, if changes were found you will be given the choice to update the Legacy database.
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You can select “Later” if you wish to perform the updates at another time, but you must not make any changes to the Legacy XE "Legacy Family Tree"  database until you complete the update process.   Even if you select “later”, you can continue to make more changes on the device.  The additional changes will be retrieved when you do the synchronization at a later time.  If you select “Now” and the database is open in Legacy, you will receive the following.  You must close the database or shut down Legacy before you can continue.
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Selecting “Later” is the same as selecting it from the previous screen.  Nothing has been applied to your original Legacy XE "Legacy Family Tree"  database.   If you make changes to the Legacy database before you process the updates, a subsequent synchronization will determine this and won’t allow the updates.  At that point, you’ll have to export a GEDCOM XE "GEDCOM"  file in order to do the updates.  (And 2-way synchronization will be turned off and will remain off unless you do a new import of the Legacy data.)

If you close the database or shut down Legacy XE "Legacy Family Tree" , you can then press “Retry” to continue.  When the updates are complete and if successful, you will be given one last chance before committing the changes to your original Legacy database. 
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It is highly recommended that you use the “Backup XE "Backup" ” function to create a backup of your Legacy XE "Legacy Family Tree"  database before you replace it with the changes.   The backup is functionally equivalent to one done by Legacy.  (You can restore it using the Legacy “Restore XE "Restore"  Family File” function.) 

When you press the “Backup XE "Backup" ” button, you then select the name and location where you wish to store the backup.   Pressing “OK” starts the backup.  You will see a progress window during the backup and a status when complete. 

If you choose to discard the updates and do the process at a later time, the original Legacy XE "Legacy Family Tree"  database will not be touched, which is the same as selecting “Later” at the beginning of the update process.  As before, you must finish the update process before you make any changes to the Legacy database.

Otherwise, if you are ready to commit your changes, press the “OK” button.   The original Legacy XE "Legacy Family Tree"  database will be replaced with the copy with the changes.  If any updates need to be synced back to the device, that will occur next.  At the end of processing, it is then safe to make changes in Legacy or on the device.
Updating the device with changes in Legacy XE "Legacy Family Tree" 
After you’ve made changes in Legacy XE "Legacy Family Tree"  and want to update the database on the device, use the “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” button in Pocket Genealogist on the desktop.  It will first check to see if any changes occurred on the device.  If none have occurred, you will then be given the chance to “refresh” the data on the device from your Legacy database.
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You can select “Later” if you wish, but if you have changed the Legacy XE "Legacy Family Tree"  database you must complete the update before you can make changes on the device.  Pressing “Later” does not prevent you from making more changes in Legacy.

If you select “Now”, the Legacy XE "Legacy Family Tree"  database is examined for any changes that have occurred since the initial import or last synchronization, and if any are found they will be synchronized to the device.  At the end of processing, it is then safe to make changes in Legacy or on the device.

Changes in both Legacy XE "Legacy Family Tree"  and Device

You may not make changes in both Legacy XE "Legacy Family Tree"  and on the device for a database and then do a 2-way synchronization.   When you do this, the sync process will determine that changes have occurred in both places and will abort the update.   No changes will be applied to the original Legacy database and the 2-way synchronization will be turned off for that database.  You will have to use the GEDCOM XE "GEDCOM"  export feature to retrieve and apply updates back to your Legacy database.

In order to turn the 2-way synchronization back on, you have to do a new import of your Legacy XE "Legacy Family Tree"  database.  (Either replacing the database on the device or creating a new one.)
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Field Notes XE "Field Notes" 
Overview

Field notes do not transfer via GEDCOM XE "GEDCOM"  file.   You must either print a copy of the notes or “cut and paste” to your desktop genealogy program.  Field Notes XE "Field Notes"  are the only data entry that can occur with the “Trial” version of Pocket Genealogist. 

Adding note on Device
Touchscreen
The Field Notes XE "Field Notes"  display on the device is almost identical to Notes, but you are limited to roughly 30,000 characters per note.

To add a new note, press the “Add” button or the “New” menu item.  A list of field note types will be displayed and you can either select one from the list and press “OK” or press the “Add” button to add a new Field Note type.  Once you’ve selected the Field Note type, the edit screen will be displayed for entering the note.

Non-Touchscreen
The Field Notes XE "Field Notes"  display on the device is almost identical to Notes, but you are limited to roughly 30,000 characters per note.


To add a new note, select “New” from the menu.  A list of field note types will be displayed and you can either select one from the list and press “Select” or select “New” from the menu to add a new Field Note type.  Once you’ve selected the Field Note type, the edit screen will be displayed for entering the note.

Field Notes XE "Field Notes"  list (Reports) 

[image: image253.png]


 First you must retrieve the notes from your device using the “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” function in Pocket Genealogist.  Select the database you wish to synchronize and press the “Synchronize” button.  After the synchronization is complete, your Field Notes XE "Field Notes"  will now be in the corresponding desktop Pocket Genealogist database.   

[image: image254.png]


 Now press the “Export” button and select “Field Notes XE "Field Notes" ” from the prompt.  The Field Notes screen will automatically select all notes that are new or changed since the last time you did a synchronize.
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You can also customize your selection criteria.  You must select at least one note category. (If you select ONLY individual or marriage, you can also specify a Record Identification Number (RIN XE "RIN" ) or Marriage XE "Marriage Event" 

 XE "Events:Marriage"  Record Identification Number (MRIN) or User Reference XE "User Reference" .)  You can also specify a date range for the notes.  If you only want notes that have been added or changed, select the “Modified Notes Only” check box.  After you pick the options that you want, press the “Refresh XE "Refresh"  List” button.  If the results are not what you want, change your options and press “Refresh List” again.

The asterisk next to the date in the list indicates that the note has been modified.  You can view any of the notes by double clicking the item in the list that interests you.  After you view a note, you may want to turn off the “modified flag” so that the note will no longer be considered “modified” the next time you query the list.

If you press the “Print” button, all notes shown in the list will be selected for printing.

Field Note Display 
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When you “double click” on one of the items in the Field Notes XE "Field Notes"  list, you will be shown more detail about that note.  You can “copy” the note from the window to “paste” into your genealogy program.  You can use your mouse to select any or all of the note or use the “Select All” button to select the entire note.  Then press the “Copy to Clipboard” so you can then “paste” it into your desktop genealogy program (or any text editor).

If this note has been modified since the last time you synchronized notes, the “Turn off modified” button will be enabled.   If you press that button the note will not show up in the list the next time you do a query for modified notes.  

If you press the “Print” button only this one note will be selected for printing.

Field Note Print
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The Print dialog allows you to either print the field notes to a printer, or to export the notes to a CSV file.  (CSV files are text files generally used with a spreadsheet program)   

The “Select” button is used to either select the printer for output, or to select the name of the CSV file if you have “CSV File XE "CSV File" ” checked.   By default, the CSV file will be given a name and location although you can override to any value you wish.  If you use the default location that is provided, the CSV files will show up on the “Logs” screen using the “Logs” button found on the main Pocket Genealogist screen.   

The output options section allows you to pick the order in which the Field Notes XE "Field Notes"  will be printed or exported to CSV.  If you have selected only one Field Note, the sort XE "Sort"  boxes will be disabled.  If you do not pick any sort options, the Field Notes will be printed in the order that they are shown in the list prior to selecting the “Print” button.  If you want only one Field Note per output page, select the “One note per page” check box.  Otherwise, more than one Field Note may be printed on a single page.  
Some options aren’t applicable when exporting to a CSV file, and they will be disabled or hidden when that option is selected.
When you press the OK button, the Field Notes XE "Field Notes"  will be printed.  As each note is sent to the printer or CSV file, details for that note will be displayed in the Print Progress section.
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Research List XE "Research List" s

Overview

Research List XE "Research List" s are a way to group Individuals, Families, Sources XE "Sources"  and Repositories into lists of your choosing.  You can create as many research lists as you like and assign any of the above items to the list for further research while you are “in the field” using Pocket Genealogist.    With the exception of Family Historian XE "Family Historian" , Research List XE "Research List" s do not transfer via GEDCOM XE "GEDCOM"  or direct import.  There is a simple export to CSV file feature for the Research Lists in Pocket Genealogist on the desktop so you can access the information you create on the device. 

Note: Family Historian XE "Family Historian"  Named Lists are converted to Research List XE "Research List" s when imported into Pocket Genealogist. 
Adding an item to a Research List XE "Research List" 
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 The “Add item to Research List XE "Research List" ” icon will be found on the screens applicable to items that can be added to a Research List  (or on menus).   Adding an item to a research list does not show you other Research List XE "Research List"  items that have already been added, it is only used to add a new item to a list.

By default there are no Research List XE "Research List" s created on the device when you import a new database.  

 Here is an example of what you might see the first time you try and add an individual to a Research List XE "Research List" .   Since there is no lists yet in existance, the first step is to create a new list.  (Use the “Add” button or the “New” menu item)


After pressing “New” or the “Add” button, we’ll enter the value “Census Records” to create a research list by that name.   After the list has been created, a Note display will be shown where you can enter a note to describe the Research List.   We are then taken back to the Research List selection screen, you can create more Research Lists now or when you first need them.   

Select the Research List for which to add the individual and press “Select”.   You will then be given a change to enter a note to attach to the person (or item) you are adding to the research list.

Viewing Research List XE "Research List" 
All Research List XE "Research List" s and the items attached to them can be found on the “Edit”, “General Details” screen.  You will see a complete list of all Research Lists you have defined and an indication of the number of items attached to the list.  

Touchscreen
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	Add a new Research List
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	Edit (View) the items on the Research List.
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	Delete a Research List and all items attached to it.  
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	View/Edit the note that describes the Research List.


Non-Touchscreen
Same as for Touchscreen but the items to manage the list will be found under “Menu”.

Working with items in a List

Select an item in the Research List and press the “Edit” button or the “Edit” menu item.   You will be shown a list of items attached to the Research List.

Touchscreen
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	Used to view/edit the item on the list. (individual, family, source or repository)  XE "Research List"   
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	Used to delete a Research List XE "Research List"  item. This does not delete the actual item attached to the list.  For example, it won’t delete an individual attached to the list, just the Research List record.
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	Used to view/edit the note for the item attached to the Research List. XE "Research List" 


Non-Touchscreen
Use the menu to edit the item on the list (which takes you to the individual, family, source or repository) or the “Note” button to view/edit the note you attached to the item when you added it to the list.

Research List XE "Research List"  Report
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 First you must retrieve the Research List XE "Research List" s from your device using the “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” function in Pocket Genealogist.  Select the database you wish to synchronize and press the “Synchronize” button.  After the synchronization is complete, your Research Lists will now be in the corresponding desktop Pocket Genealogist database.   
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Now press the “Export” button and select “Research List XE "Research List" ” from the prompt.  The Research List screen will show a display similar to what is on the device.
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Select an item from the top list will show the details of the items attached to that list.  Pressing the “CSV File XE "CSV File" ” will create a CSV file just for that Research List XE "Research List" .   Repeat that process to create a CSV File for the other lists.

By default, the CSV file will be given a name and location although you can override to any value you wish.  If you use the default location that is provided, the CSV files will show up on the “Logs” screen using the “Logs” button found on the main Pocket Genealogist screen.   
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Changes Report

Overview

If you are not using the 2-way synchronization feature with Legacy Family Tree or don’t feel comfortable merging an exported GEDCOM into your desktop program, you can use the changes report to display the changed information made on your device.   Information can then be printed or manually entered into your desktop program.

Changes Report Generation
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 First you must retrieve the changes  XE "Research List" from your device using the “Synchronize XE "Synchronization:Database" 

 XE "Database:Synchronization" ” function in Pocket Genealogist.  Select the database you wish to synchronize and press the “Synchronize” button.  After the synchronization is complete, the changed information will now be in your desktop Pocket Genealogist database.   
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Now press the “Export” button and select “Changes made on the device XE "Research List" ” from the prompt.  
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The Changes Report screen gives you some options with regards to how much information is displayed.    For example, it may be useful to include spouses, children or parents for a changed individual even if those people did not have any changes.
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Press “Start” to produce the report.  After generating the report but before display, it will ask if you wish to ‘turn off’ the modified flag so that subsequent reports won’t show the same information.
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If you say ‘No’, subsequent reports will continue to show the same changes.   After responding to this prompt, the changes report will be displayed in your default internet browser.     Items in yellow indicate a change, red indicate deletion and green indicates addition. 
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RIN:1
Sex Male
Living: No
Private: No
Ancin:
Des Int
Never Married: No
User Re.
Pt
UID: 5221FACOEFBF4BE1AF1FES3ABIDFOAE

As Spouse: Elizabeth Reynolds
As Spouse: Eleanor Huffman

Event: Residence
Date: 22 Jun 1852
[ comiment: Changed this Event.
Location:, Lawrence County, Pennsyivania, USA
Note (Location);
Latitude / Longitude (Location): Ne0.9910558 / W80.3340964
Private: No

Event: Census
Date: 6 Nov 1850
Comment:
Location: Richfield, Hennepin, Minnesota, USA
Note (Location}:
Latitude / Longitude (Location): N44.8811253 / W93.2679339
Private: No

[[ Deleted ] Residence

Date: 27 Feb 1856
Comment:
Location: New Brighton, Beaver, Pennsyivania, USA
Note (Location);
Latitude / Longitude (Location): Ne0.7364161 / W80.3156206
Private: No

Event: Residence
Date: 1865
Comment:
Location: Minneapolis, Hennepin, Minnesota, USA

Note (Location): MINNEAPOLIS, founded by Col. John . Stevens, builder of the first house on the west side of the Mississippi here in 1845-50, organized as a
township May 11, 1858, was transformed in 1886 10 the village organizations of Golden Valley and St. Louis Park, excepting the eastern part
of the township, which had been comprised in the city area. ... [SOURCE: Minnesota Place Names, A Geographical Enciclopedia, online ,
Minneapolis data downloaded 15 February 2002]
Latitude / Longitude (Location): Ne4 9802775 / W93.2636108
Private: No

[ Added ] Vacation

Date: 12 Aug 2010
Comment: Added a new Event.

Private: No

Done

Computer | Protected Mode: Off v R110%
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Uninstalling XE "Uninstalling"  Pocket Genealogist

Desktop uninstall
1. Start Pocket Genealogist on the desktop and press the “Tools” button.

2. Select all items under “Data created by Pocket Genealogist” and then press the “Delete” button.  Pocket Genealogist will automatically exit.
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3. Go to the Windows Control Panel from “Start”, “Settings”, “Control Panel”. (XP Shown)
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Or on Windows 7 and Vista, it may look like this:
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4. Select “Add or Remove Programs” with XP and “Programs and Features” with Vista or Windows 7.
5. With Windows XP, select the version of Pocket Genealogist from the list you wish to remove and press ‘Change/Remove” (shown).  With Vista or Windows 7, select the item in the list and right mouse button to select “Uninstall”.
[image: image278.png]'E dd or Remove Programs (=]

Y| comnty e o O shovmes St 9]

Changs or
Remave
Programs

B, pocet Controler-Professons s sz ©

Pocket Genealogist

e Pocket Genedogst v3 See

.50ME




6. The “Removal Wizard” will be displayed, follow the instructions to remove Pocket Genealogist.
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Device Uninstall

1. Make sure Pocket Genealogist is not running on the device. 

2. From the “Start” menu select “Settings”.

3. Select the “System” tab.

4. Select the item in the list you wish to uninstall and press “Remove”.
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5. Select “Yes” to the uninstall prompt.
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6. If you are totally removing Pocket Genealogist, say “Yes”.  This will remove all customization values including your registration code. 
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7. If you are totally removing Pocket Genealogist say “Yes”.  This will remove all databases on the device.   Note:  Databases between Version 2, Version 3 and Version 4 of Pocket Genealogist are not interchangeable… if you are upgrading to Version 4, it is safe  (And desirable) to remove Version 3 databases.
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8. If you have storage cards XE "Storage Card"  that may have databases on it, insert the card now and say “Yes”.  Do that for every storage card that contains databases.    When you are ready to continue say “No”.
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Appendix

B
GEDCOM XE "GEDCOM"  creation

The following are some specific examples for creating GEDCOM XE "GEDCOM"  files.  Even if your program is not listed, you may find some helpful hints that may be applicable to your situation.  It is assumed, in all cases below, that your database is “open” before you start any of these processes.

Family Origins XE "Family Origins"  v10

1. “File” menu.

2. “GEDCOM XE "GEDCOM" ” menu item.

3. “Export GEDCOM XE "GEDCOM" …” menu item.

4. Enter the name and location where you want to put the GEDCOM XE "GEDCOM"  file.  GEDCOM files should have a file extension of “ged”.

5. Select “entire database” if you want all individuals or “Select people” if you want to be presented with the ability to select only certain individuals.

6. Use the “General” destination type.

7. “Correspondence log” and “Multimedia links” aren’t supported but won’t harm anything if included.

8. Press OK to create the GEDCOM XE "GEDCOM"  file.  (If you selected “Select people”, you will be given the chance to pick who you want in the GEDCOM file).

Note: RootsMagic XE "RootsMagic"  is similar.

Family Tree Maker XE "Family Tree Maker"  v11

For all individuals in the Database
1. “File” menu.

2. “Copy/Export Family File” menu item.

3. Change the “Save as type” to “GEDCOM XE "GEDCOM"  (*.GED)”.

4. Enter the name and location where you want to put the GEDCOM XE "GEDCOM"  file.  GEDCOM files should have a file extension of “ged”.  (FTM XE "Family Tree Maker"  version 11 automatically “fills in” the name while older versions do not)

5. If the file already exists, it won’t let you overwrite it.  However, you can select the file in the list and press the delete button, then create the new file.

6. Destination is generally set to “FTW”.

7. GEDCOM XE "GEDCOM"  is generally set to “Version 5.5”.

8. Character set is generally set to “ANSI XE "ANSI" ”.

9. Indent is generally not selected.

10. Abbreviate is generally selected.

For some individuals in the Database

1. Create either a Report, Ancestor tree, Descendant tree, or Outline Descendant tree.

2. Using the right mouse button to pick options or the menu. (“Contents”)

3. Select the individuals you want in the report or tree.  (“Individuals to include”)

4. “File” menu

5. “Copy/Export Individuals in …..”

6. Follow the same steps as above starting with step #3.
Generations v8.5

1. “File” menu.

2. “Import XE "Import" 

 XE "Database:Import" /Export” menu item.

3. “Export GEDCOM XE "GEDCOM" …” menu item.

4. Select “Who” you want to export.

5. Destination is generally “GEDCOM XE "GEDCOM"  5.5”.

6. Character set is generally “Windows”.

7. Select “Optional Fields” and make sure that the data you want to include is “checked”.

8. Press “Export” and you will be given a chance to pick the name and location of the GEDCOM XE "GEDCOM"  file.  GEDCOM files should have a file extension of “ged”.

Personal Ancestral File XE "Personal Ancestral File"  v5

1. “File” menu.

2. “Export…” menu item.

3. Set “Export To” to “Other GEDCOM XE "GEDCOM"  5.5”.

4. UTF-8 XE "UTF-8"  or ANSI XE "ANSI"  is recommended as the Char Set.

5. Select what you want to “include”. (Multimedia links are not supported but won’t cause any harm if included.)
6. If you select “Partial” under “Filter”, you can choose which individuals are included in the GEDCOM XE "GEDCOM"  file.

7. Press “Export” and you will be given a chance to pick the name and location of the GEDCOM XE "GEDCOM"  file.  GEDCOM files should have a file extension of “ged”.
Ultimate Family Tree XE "Ultimate Family Tree"  v3

1. “File” menu.

2. “Save As…” menu item.

3. Change “Save file as type” to “GEDCOM XE "GEDCOM" ”.

4. Enter the name and location of the GEDCOM XE "GEDCOM"  file.

5. “Family 5.5” is generally used as the GEDCOM XE "GEDCOM"  Format.
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Import XE "Import" 

 XE "Database:Import"  Limitations

This section discusses limitations with the various imports.  This information may change with each release as new imports are added or enhancements made to imports.  

GEDCOM XE "GEDCOM" 
Every desktop genealogy program creates GEDCOM XE "GEDCOM"  files different from each other.  The Pocket Genealogist “Profiles” provide a means to control the import and export of these GEDCOM files to provide a superior transfer of data and to make sure only data that is acceptable to the originating program is entered on the device.

Every attempt is made to support all the features in a GEDCOM XE "GEDCOM"  file.  There are still some data types that are not supported, such as multimedia objects.  (Multimedia objects are not supported by any import.)

GenBridge XE "GenBridge"  PAF XE "Personal Ancestral File"  imports

· Problems will occur if you use the | character in notes.

GenBridge XE "GenBridge"  FTM XE "Family Tree Maker"  imports (Prior to FTM 2008)
· The marriage reference # is not currently available.

· Under some circumstances, the order of children may not be correct.
· Multimedia is not supported.

GenBridge XE "GenBridge"  FTM XE "Family Tree Maker"  2008 imports 
· Fact and Name notes are not imported.

· Spouses without a “family” fact or children will not be imported.

· Not all multimedia data associated with an image is imported.

GenBridge XE "GenBridge"  FTM XE "Family Tree Maker"  2010 imports 
· Not supported

Note: The above four limitations are as of August 12, 2010.  Check the Northern Hills Software website to see if these items have been fixed.

Legacy XE "Legacy Family Tree"  Version 5 through 7 “Direct” imports

· All data is supported except for non-image multimedia object (Sound and Text files for example)
TMG XE "The Master Genealogist"  “Direct” imports

· Templates are not supported.

· Location “elements” are not supported.   (Locations are stored as one value in Pocket Genealogist.)

· Research Log XE "To Do:Research Log" 

 XE "Research Log (See also To Do)"  is transferred but cannot be modified on the device.

· Most source elements cannot be modified on the device.
Ancestral Quest XE "Ancestral Quest"  “Direct” imports

· The order of Parents is not currently supported.

· Page of Testimony is not supported  (although the individual components will transfer).

· The “To Do XE "To Do" ” order is not currently supported.

· The source field “Abbreviated Author” is not currently supported.

RootsMagic XE "RootsMagic"  “Direct” imports

· Correspondence List is not supported

· Primary/Secondary addresses are not supported.  (The first address found in the database will be imported.)

· No distinction between primary and secondary repositories for sources.

· The reference to a family for an adopted event is not supported.

· Dates on Alternate names are not supported.

· The “preferred” flag for individuals are transferred but cannot be changed on the device.

Genbox XE "Genbox"  “Direct” imports

· Too numerous to mention.   This import is best when used with the “View Only XE "Options:View Only databases" 

 XE "Database:View Only" 

 XE "Database:Read Only" 

 XE "Read only database" 

 XE "View Only database" 

 XE "Locking the database" 

 XE "Database:Locking" ” option.  

Appendix
D
FreeImage License
The Pocket Genealogist image import was developed using the FreeImage image conversion library which is used to ‘scale’ the size of desktop images to work better on the smaller device screens.   The license for the use of this library is included below.

FreeImage Public License - Version 1.0

---------------------------------------------

1. Definitions.

1.1. "Contributor" means each entity that creates or contributes to the creation of Modifications.

1.2. "Contributor Version" means the combination of the Original Code, prior Modifications used by a Contributor, and the Modifications made by that particular Contributor.

1.3. "Covered Code" means the Original Code or Modifications or the combination of the Original Code and Modifications, in each case including portions thereof.

1.4. "Electronic Distribution Mechanism" means a mechanism generally accepted in the software development community for the electronic transfer of data.

1.5. "Executable" means Covered Code in any form other than Source Code.

1.6. "Initial Developer" means the individual or entity identified as the Initial Developer in the Source Code notice required by Exhibit A.

1.7. "Larger Work" means a work which combines Covered Code or portions thereof with code not governed by the terms of this License.

1.8. "License" means this document.

1.9. "Modifications" means any addition to or deletion from the substance or structure of either the Original Code or any previous Modifications. When Covered Code is released as a series of files, a

Modification is:

A. Any addition to or deletion from the contents of a file containing Original Code or previous Modifications.

B. Any new file that contains any part of the Original Code or previous Modifications.

1.10. "Original Code" means Source Code of computer software code which is described in the Source Code notice required by Exhibit A as Original Code, and which, at the time of its release under this License is not already Covered Code governed by this License.

1.11. "Source Code" means the preferred form of the Covered Code for making modifications to it, including all modules it contains, plus any associated interface definition files, scripts used to control

compilation and installation of an Executable, or a list of source code differential comparisons against either the Original Code or another well known, available Covered Code of the Contributor's choice. The Source Code can be in a compressed or archival form, provided the appropriate decompression or de-archiving software is widely available for no charge.

1.12. "You" means an individual or a legal entity exercising rights under, and complying with all of the terms of, this License or a future version of this License issued under Section 6.1. For legal entities, "You" includes any entity which controls, is controlled by, or is under common control with You. For purposes of this definition, "control" means (a) the power, direct or indirect, to cause the

direction or management of such entity, whether by contract or otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership of such entity.

2. Source Code License.

2.1. The Initial Developer Grant.

The Initial Developer hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Original Code (or portions thereof) with or without Modifications, or as part of a Larger Work; and

(b) under patents now or hereafter owned or controlled by Initial Developer, to make, have made, use and sell ("Utilize") the Original Code (or portions thereof), but solely to the extent that

any such patent is reasonably necessary to enable You to Utilize the Original Code (or portions thereof) and not to any greater extent that may be necessary to Utilize further Modifications or

combinations.

2.2. Contributor Grant.

Each Contributor hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Modifications created by such Contributor (or portions thereof) either on an unmodified basis, with other Modifications, as Covered Code or as part of a Larger Work; and

(b) under patents now or hereafter owned or controlled by Contributor, to Utilize the Contributor Version (or portions thereof), but solely to the extent that any such patent is reasonably necessary to enable You to Utilize the Contributor Version (or portions thereof), and not to any greater extent that

may be necessary to Utilize further Modifications or combinations.

3. Distribution Obligations.

3.1. Application of License.

The Modifications which You create or to which You contribute are governed by the terms of this License, including without limitation Section 2.2. The Source Code version of Covered Code may be distributed only under the terms of this License or a future version of this License released under Section 6.1, and You must include a copy of this License with every copy of the Source Code You distribute. You may not offer or impose any terms on any Source Code version that alters or

restricts the applicable version of this License or the recipients' rights hereunder. However, You may include an additional document offering the additional rights described in Section 3.5.

3.2. Availability of Source Code.

Any Modification which You create or to which You contribute must be made available in Source Code form under the terms of this License either on the same media as an Executable version or via an accepted Electronic Distribution Mechanism to anyone to whom you made an Executable version available; and if made available via Electronic Distribution Mechanism, must remain available for at least twelve (12) months after the date it initially became available, or at least six (6) months after a subsequent version of that particular Modification has been made available to such recipients. You are responsible for ensuring that the Source Code version remains available even if the Electronic Distribution Mechanism is maintained by a third party.

3.3. Description of Modifications.

You must cause all Covered Code to which you contribute to contain a file documenting the changes You made to create that Covered Code and the date of any change. You must include a prominent statement that the Modification is derived, directly or indirectly, from Original Code provided by the Initial Developer and including the name of the Initial Developer in (a) the Source Code, and (b) in any notice in an Executable version or related documentation in which You describe the origin or ownership of the Covered Code.

3.4. Intellectual Property Matters

(a) Third Party Claims.

If You have knowledge that a party claims an intellectual property right in particular functionality or code (or its utilization under this License), you must include a text file with the source code distribution titled "LEGAL" which describes the claim and the party making the claim in sufficient detail that a recipient will know whom to contact. If you obtain such knowledge after You make Your Modification available as described in Section 3.2, You shall promptly modify the LEGAL file in all copies You make

available thereafter and shall take other steps (such as notifying appropriate mailing lists or newsgroups) reasonably calculated to inform those who received the Covered Code that new knowledge has been obtained.

(b) Contributor APIs.

If Your Modification is an application programming interface and You own or control patents which are reasonably necessary to implement that API, you must also include this information in the LEGAL file.

3.5. Required Notices.

You must duplicate the notice in Exhibit A in each file of the Source Code, and this License in any documentation for the Source Code, where You describe recipients' rights relating to Covered Code. If You created one or more Modification(s), You may add your name as a Contributor to the notice described in Exhibit A. If it is not possible to put such notice in a particular Source Code file due to its

structure, then you must include such notice in a location (such as a relevant directory file) where a user would be likely to look for such a notice. You may choose to offer, and to charge a fee for, warranty, support, indemnity or liability obligations to one or more recipients of Covered Code. However, You may do so only on Your own behalf, and not on behalf of the Initial Developer or any Contributor. You must make it absolutely clear than any such warranty, support, indemnity or

liability obligation is offered by You alone, and You hereby agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial Developer or such Contributor as a result of

warranty, support, indemnity or liability terms You offer.

3.6. Distribution of Executable Versions.

You may distribute Covered Code in Executable form only if the requirements of Section 3.1-3.5 have been met for that Covered Code, and if You include a notice stating that the Source Code version of the Covered Code is available under the terms of this License, including a description of how and where You have fulfilled the obligations of Section 3.2. The notice must be conspicuously included in any notice in an Executable version, related documentation or collateral in which You

describe recipients' rights relating to the Covered Code. You may distribute the Executable version of Covered Code under a license of Your choice, which may contain terms different from this License,

provided that You are in compliance with the terms of this License and that the license for the Executable version does not attempt to limit or alter the recipient's rights in the Source Code version from the rights set forth in this License. If You distribute the Executable version under a different license You must make it absolutely clear that any terms which differ from this License are offered by You alone, not by the Initial Developer or any Contributor. You hereby agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial Developer or such Contributor as a result of any such terms You offer.

3.7. Larger Works.

You may create a Larger Work by combining Covered Code with other code not governed by the terms of this License and distribute the Larger Work as a single product. In such a case, You must make sure the requirements of this License are fulfilled for the Covered Code.

4. Inability to Comply Due to Statute or Regulation.

If it is impossible for You to comply with any of the terms of this License with respect to some or all of the Covered Code due to statute or regulation then You must: (a) comply with the terms of this License to the maximum extent possible; and (b) describe the limitations and the code they affect. Such description must be included in the LEGAL file described in Section 3.4 and must be included with all distributions of the Source Code. Except to the extent prohibited by statute or regulation, such description must be sufficiently detailed for a recipient of ordinary skill to be able to understand it.

5. Application of this License.

This License applies to code to which the Initial Developer has attached the notice in Exhibit A, and to related Covered Code.

6. Versions of the License.

6.1. New Versions.

Floris van den Berg may publish revised and/or new versions of the License from time to time. Each version will be given a distinguishing version number.

6.2. Effect of New Versions.

Once Covered Code has been published under a particular version of the License, You may always continue to use it under the terms of that version. You may also choose to use such Covered Code under the terms of any subsequent version of the License published by Floris van den Berg

No one other than Floris van den Berg has the right to modify the terms applicable to Covered Code created under this License.

6.3. Derivative Works.

If you create or use a modified version of this License (which you may only do in order to apply it to code which is not already Covered Code governed by this License), you must (a) rename Your license so that the phrases "FreeImage", `FreeImage Public License", "FIPL", or any confusingly similar phrase do not appear anywhere in your license and (b) otherwise make it clear that your version of the license contains terms which differ from the FreeImage Public License. (Filling in the name of the Initial Developer, Original Code or Contributor in the notice described in Exhibit A shall not of themselves be deemed to be modifications of this License.)

7. DISCLAIMER OF WARRANTY.

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED CODE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

8. TERMINATION.

This License and the rights granted hereunder will terminate automatically if You fail to comply with terms herein and fail to cure such breach within 30 days of becoming aware of the breach. All sublicenses to the Covered Code which are properly granted shall survive any termination of this License. Provisions which, by their nature, must remain in effect beyond the termination of this License shall survive.

9. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE

EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THAT EXCLUSION AND LIMITATION MAY NOT APPLY TO YOU.

10. U.S. GOVERNMENT END USERS.

The Covered Code is a "commercial item," as that term is defined in 48 C.F.R. 2.101 (Oct. 1995), consisting of "commercial computer software" and "commercial computer software documentation," as such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Code with only those rights set forth herein.

11. MISCELLANEOUS.

This License represents the complete agreement concerning subject matter hereof. If any provision of this License is held to be unenforceable, such provision shall be reformed only to the extent necessary to make it enforceable. This License shall be governed by Dutch law provisions (except to the extent applicable law, if any, provides otherwise), excluding its conflict-of-law provisions. With respect to disputes in which at least one party is a citizen of, or an entity chartered or registered to do business in, the The Netherlands: (a) unless otherwise agreed in writing, all disputes relating to this License (excepting any dispute relating to intellectual property rights) shall be subject to final and binding arbitration, with the losing party paying all costs of arbitration; (b) any arbitration relating to this Agreement shall be held in Almelo, The Netherlands; and (c) any litigation relating to this Agreement shall be subject to the jurisdiction of the court of Almelo, The Netherlands with the losing party responsible for costs, including without limitation, court costs and reasonable attorneys fees and expenses. Any law or regulation which provides that the language of a contract shall be construed against the drafter shall not apply to this License.

12. RESPONSIBILITY FOR CLAIMS.

Except in cases where another Contributor has failed to comply with Section 3.4, You are responsible for damages arising, directly or indirectly, out of Your utilization of rights under this License, based

on the number of copies of Covered Code you made available, the revenues you received from utilizing such rights, and other relevant factors. You agree to work with affected parties to distribute

responsibility on an equitable basis.

EXHIBIT A.

"The contents of this file are subject to the FreeImage Public License Version 1.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://home.wxs.nl/~flvdberg/freeimage-license.txt

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.
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Customizing the Import
41

Legacy Family Tree
2, 33, 41, 48, 49, 62, 69, 75, 76, 77, 78, 81, 86, 92, 122, 129, 143, 167, 168, 169, 170, 171, 198

Import Location
29

Legacy Installation
41

Limiting

Size of Citation Notes
40

Size of Event Notes
40

Linking

Child
111

Parents
112

Spouse
110

Lists

Column Position
30, 85

Column Width
30, 85

Living
59, 64, 125

Location

Adding
106

Commas when missing
42

Finding
134

Place
46, 69, 106

Prompt (disabling)
152

Reversing Order
42

Locking the database
30, 40, 64, 77, 85, 86, 131, 143, 198

Logs

Pocket Genealogist
86

Longitude (Coordinates)
42, 63, 106

Lookup
62, 106, 107, 108

Marriage Event
40, 42, 44, 45, 46, 49, 57, 66, 73, 157, 175

Master Lists
157, 168

Microsoft database drivers
16

Multimedia

Displaying
147

Find (Non-Touchscreen)
141

Find (Touchscreen)
140

Icon
64

Import, Ancestral Quest
45

Import, GEDCOM
40

Import, Genbox
44

Import, Legacy Family Tree
41

Import, PAF/FTM Add-on
46

Import, RootsMagic
45

Import, The Master Genealogist
43

Name

Adding an AKA
103

Adding secondary
103

Finding
132

Swapping
104

Never Married
122, 129

Not Married
122

Notes

Adding
99

Auto-Capitalization
152

Field Selection
152

Format Code (hiding)
152

Format Code removal
42

Opening a device database
56

Options

Comment / Location Import Options
40, 46

Customizing the Import
39

Import Location on desktop
29

Sounds
29

View Only databases
30, 40, 64, 77, 85, 86, 131, 143, 198

Orphan (databases)
78

PAF/FTM add-on
33, 36, 52

Customizing the import
46

Parents

Adding
94

Deleting
112

Linking
112

List
112

Preferred
120

Unlinking
112, 115

Personal Ancestral File
33, 46, 52, 196, 197

Customizing the PAF/FTM add-on Import
46

Photos

Displaying
147

Place
46, 69, 106

Preferred
62, 66, 104, 118, 119, 120, 126, 127, 131, 148

Primary Events
40, 42, 45, 46, 66

Primary Events First
40

Primary Events Only
40, 42, 44, 46

Primary name
61, 103

Private
125

Processing Changes Report
83

Processing Field Notes
82

Processing Research List
82

RAPI Security Policy
22

Read only database
30, 40, 64, 77, 85, 86, 131, 143, 198

Refresh
38, 63, 76, 155, 156, 157, 175

Regional Settings

Use of
12, 142

Registration (unlock) code
27, 55

Re-installing Pocket Genealogist
12

Relationship Calculator
161

Relationship List
60

Relationships
71, 72, 121, 157

Remove Customization Values

Desktop
26

Remove Format Codes
42

Repository
64, 138, 139, 157

Research List
64, 77, 83, 92, 102, 179, 180, 181, 182, 183, 185

Adding
102

Processing
82

Research Log (See also To Do)
43, 157, 198

Restore
64, 157, 170

RFN
124

RIN
61, 130, 175

Roles and Witnesses
43

RootsMagic
33, 45, 51, 195, 198

Customizing the Import
45

Import Location
29

Sex
59, 64, 125

Shortcut

Desktop
14

Program (Desktop)
14

Start Menu (Desktop)
14

Size Limits
40

Smart Minimize
151

Soft Reset
54, 163

Sort
61, 62, 126, 177

Soundex

Calculator
160

Sounds

At completion of an event
29, 78

Export complete
29

Import complete
29

Synchronization complete
29

Source Citation
62, 97, 98, 129

Adding
97

Sources
44, 45, 68, 101, 102, 157, 179

Adding
97, 98

Spouse

Adding
94

Deleting
112, 114

Linking
110

Preferred
118

Unlinking
114, 115

Spouse List
60, 110, 112, 114, 118

Storage Card
155, 194

Formatting
163

Suffix

Adding
109

Surname
61, 108, 158

Adding
108

Dual
40, 41

Prompt (disabling)
152

Uppercase
40, 44, 45, 151

Synchronization

2-way
33, 48, 49, 167

Database
34, 48, 53, 77, 78, 80, 82, 83, 167, 169, 171, 175, 183, 185

Device Configuration
32

Location with most space
32

Tab Order
154

Tap and Hold

Tips
94

TCP/IP
86

Temple
69

The Master Genealogist
2, 33, 43, 50, 62, 69, 71, 81, 101, 121, 157, 198

Customizing the Import
42

Flags
142

Import Location
29

Tips
34, 35, 58, 59, 71, 85, 94, 100, 137

Icon
94

To Do
43, 63, 69, 92, 101, 102, 136, 137, 138, 139, 142, 157, 198

Adding
101

Finding
136, 138

Research Log
43, 157, 198

Ultimate Family Tree
196

Unicode
33

Uninstalling
189

Unknown Publisher

Device Install
21

Unlink

Child
113, 116

Parent
112, 115

Spouse
114, 115

Unsupported GEDCOM Tags
40

Uppercase Surnames
40, 44, 45, 151

User Reference
124, 175

UTF-8
33, 81, 196

VGA
153

View

3-Generation
57, 58

3-Generation Colors
149

Ancestor Tree
59, 60, 63

Ancestor Tree (Expanding node)
60, 63

Changing
143

Default
148

Descendant Tree
59, 60, 63

Descendant Tree (Expanding node)
60, 63

Individual
61

Tree generations to display
148

View Only database
30, 40, 64, 77, 85, 86, 131, 143, 198

Wife Phrase
122

Windows Mobile 5 or 6
20, 86, 144

Working with Dates
95, 164




Copyright and Terms of Use 

Pocket Genealogist™ is the copyrighted work of Northern Hills Software LLC. Use of the Software is governed by the terms of the end user license agreement, if any, which accompanies or is included with the Software ("License Agreement").  An end user who is willing to use the Software agrees to the License Agreement terms. The copyright is owned by Northern Hills Software LLC. In no event shall Northern Hills Software LLC be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits arising out of or in connection with the use or performance of the Software.

Any rights not expressly granted herein are reserved.

(C) 1999-2010 Northern Hills Software LLC. All rights reserved.

Changes to this Document


This information can be used to determine which pages to print to update your documentation without printing out the complete document.  
Version 4.00 (August 15, 2010)
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